
R:BASE Technologies, Inc.

to

R:BASE eXtreme 9.5

What's eXclusive



What's eXclusive to R:BASE eXtreme 9.5

by R:BASE Technologies, Inc.

Welcome to R:BASE eXtreme 9.5!

This document details the "9.5" specific features that have been
added to R:BASE eXtreme.

R:BASE eXtreme for Windows is a new relational database
development environment that has been amplified to provide the
latest menu-driven features to database professionals. With the
R:BASE engine established as the foundation of stability, the
program interface and designers have been enhanced to fully
exhibit a higher quality of development usability.

The "eXtreme" in the product's name signifies the cutting-edge
development interface incorporated into the R:BASE program
making database and application development more productive.
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1 PDF Form Controls for Reports and Labels

PDF Form Controls allow for PDF output to provided to others so data can be inserted into
fields. 

There are eight different form controls. Each tool is used to create the respective field type. 

After creating a field, users can right click on the control for added properties. 

1.1 PDF Annotation

This object looks like a “sticky note”. Users can pre-define the following type of annotations:

Comment
Key
Note
Help
New Paragraph
Paragraph
Insert

PDF Annotation Examples:

Annotation display in a PDF file when the mouse button has been clicked:
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The following properties for PDF Annotation object are also available:

Border Color
Subject
Title
Contents

1.2 PDF Push Button

Push buttons can be one of the three kinds:

Submit button
Reset button
Java Script button.

Submit button can be used to submit data from the form fields to e-mail or http, reset button
will return all form fields to original state and java script button will start a java script after click.

Other properties available for Push Buttons:

Border Color
Background Color
Down Caption
Field Name
Normal Caption
Rollover Caption

Push Button Examples:

1.3 PDF Text Field

Text fields in PDF Forms can be used for entering text data. They can be single line or multi-line.
Text field data can be accessed by a java script function.
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Other properties available for Text Fields:

Border Color
Background Color
Field Name
Border
Do not Scroll
Do not Spell Check
Password
Max Length

Text Field Examples:

1.4 PDF Check Box

Check Box controls are shown in the PDF document as a square box that can contain white
space (for false) or a tick mark (for true).

Check Box fields in PDF Forms can be the following:

Check
Circle
Cross
Diamond
Square
Star

Other properties for Check Box controls:

Background Color
Border Color
Checked
Field Name

Check Box data can be accessed by a java script. 

Check Box Examples:
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1.5 PDF Radio Button

A Radio Button is a type of PDF control element that allows the user to choose only one of a
predefined set of options. These set is controlled by property “Field Name” property, e.g.
different Radio Buttons with same “Field Name” forming the one group.  It is possible that
initially none of the radio buttons in a group are selected.

Other Radio Button properties:

Background Color
Border Color
Checked
Field Name
Value

Radio Button data can be accessed by a java script.

Radio Button Examples:

1.6 PDF Combo Box

Combo Box in PDF document is a combination of a drop-down list or list box and a single-line
text box, allowing the user to either type a value directly into the control or choose from the list
of existing options.

Combo Box data can be accessed by a java script.

Other Combo Box properties:

Background Color
Border Color
Field Name
Editable
Sort List
Items
Selected Item Index
Value

Combo Box Examples:
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1.7 PDF List Box

A List Box is a PDF Control that allows the user to select one or more items from a list contained
within a static, multiple line text box. The user clicks inside the box on an item to select it.

List Box data can be accessed by a java script.

Other Combo Box properties:

Background Color
Border Color
Field Name
Multi Select
Sort List
Items
Value

List Box Example:

1.8 PDF Signature Field

A Signature Field is a specialized type of form field used for collecting signatures.

2 Enhanced Form/Report/Label DOS to Windows
Conversion

The conversion process for DOS database to Windows has been enhanced a great deal to
streamline the transition to R:BASE eXtreme 9.5 for Windows. 

The CONVERT command was updated to support the conversion of 4.5 and higher databases.
Support for password protected databases is included.

Individual forms can be selected and converted. Multiple forms can be converted by holding the
[Ctrl] key and selecting individual form names. Or pressing the [Ctrl]+[A] keys will select all
listed forms. Combined text lines are automatically separated into separate text fields. All
controls are converted using a standard mono-spaced font for proper display.



What's eXclusive to R:BASE eXtreme 9.5 for Windows6

Copyright © 1982-2016 R:BASE Technologies, Inc.

The "Properties" button provides a form conversion option to change single and double line
characters to blanks. 

Individual reports/labels can be selected and converted. Multiple items can be converted by
holding the [Ctrl] key and selecting individual names. Or pressing the [Ctrl]+[A] keys will select
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all listed items. In the process hyphen and equal characters are converted to lines and double
lines. All controls are converted using a standard mono-spaced font for proper display.
Compressed DOS reports/labels will convert using the Size 6 Courier New font.

The "Properties" button provides conversion options to change single and double line
characters to blanks, a pass setting, and margins (figure 5). 

3 Legacy Application File Conversion

Within the External Form File portion of the Database Explorer, a new "Convert
Application(s)..." option is available. This feature converts Windows and DOS legacy
application files (.APP/.API) to an External Form File. 
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Selecting this option will parse through the $COMMAND blocks legacy application file and store
each as a Custom Form Action within an External Form. 

For legacy application files that contain $MENU Blocks, a menu system will be created within the
External Form. If the legacy application file uses a "pull down" type of menu system, the
converted result will be a Menu Bar layout in R:BASE eXtreme for Windows. If the legacy
application file uses a "columnar" type of menu system, a Group Bar or Tree View can be
specified as the converted result.

4 Integrated Windows Authentication (IWA)

Integrated Windows Authentication (IWA) is the automatically authenticated connections
between Microsoft IIS, Internet Explorer, and other Active Directory aware applications. 

In R:BASE, support for Integrated Windows Authentication uses the security features of
Windows clients and servers and allows access to an R:BASE database when the Windows
user name and password matches a defined R:BASE database user name and password. The
current Windows user information on the client computer is supplied to R:BASE and does not
prompt user for additional user name and password.

In order to use this feature, R:BASE database administrators must create an owner and user
privileges for the database files to take full advantage of IWA support. 

In addition to creating the database user privileges, the operating condition WINAUTH must be
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set to ON when prior to users connecting to the database. WINAUTH can be set within the
R:BASE configuration file, or defined within an application startup file. 

Requirements:

WINAUTH must be set ON before connecting to the database.

Database must contain an owner and user privileges that match Windows network
accounts.

Notes:

R:BASE will accept user names that contain spaces.

Passwords are case-sensitive.

If the authentication exchange initially fails to identify the user, R:BASE will prompt the
user for a user name and password. 

A new CVAL Function  (CVAL('WINAUTH')) has been established to check if WINAUTH is on.

When an R:BASE user successfully connects to the database via IWA, the current R:BASE
USER identifier is set to the current Windows user name.

The WINAUTH setting is specific to R:BASE eXtreme 9.5 (64).

5 New GUID Data Type

The new GUID data type allows for the use of a globally unique identifier value to store 100%
unique values into a primary key column. As the GUID data type is a binary value, it will
increase retrieval of data from tables.

An example of a GUID value is: 8C20005C-0E2A-47E0-B2BE-57E67961628B

This data type is only available in R:BASE eXtreme 9.5 (64).

6 New "Time Picker" Form Controls

A new Time Picker control has been added to the Form Designer to display a clock to edit time
values. A standard Time Picker, DB Time Picker, and Variable Time Picker is available.
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7 New "Enhanced Calendar" Form Controls

A new Enhanced Calendar control has been added to the Form Designer to display an improved
calendar to browse and select dates. A standard Enhanced Calendar, Enhanced DB Calendar,
and Enhanced Variable Calendar is available.

8 New "Collapse Panel" Control

A new Collapse Panel control has been added to the Form Designer to display a special panel
that will collapse and recede when clicked upon to contain form controls. A more recent
enhancement allows for an EEP to be executed when the collapse state for the panel is
changed.
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9 New CVAL Functions

01.
A new CVAL Function  (CVAL('WINAUTH')) has been established to check if WINAUTH is on.
WINAUTH toggles the support for Integrated Windows Authentication when connecting to
R:BASE databases.

SET VAR vWinAuthChk TEXT = (CVAL('WINAUTH')) 
SHOW VAR vWinAuthChk

Variable                         = Value                               
   Type
--------------------------------   ------------------------------      
   -------
vWinAuthChk                      = OFF                                 
    TEXT

02.
A new CVAL Function  (CVAL('GUID')) is available to generate a a globally unique identifier
value.

SET VAR vNewGUID = (CVAL('GUID'))
SHOW VAR vNewGUID
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Variable                         = Value                               
   Type
--------------------------------   ------------------------------      
   -------
vNewGUID                         = BEDA7594-F6C1-44BD-A732-4BB72F17A1DA
    TEXT    
                     

03.
A new CVAL Function (CVAL('NETGROUP')) is available to retrieve a list of global groups to which
a specified user belongs.

04.
A new CVAL Function (CVAL('NETLOCALGROUP')) is available to retrieve a list of local global
groups to which a specified user belongs.

SET VAR vNetGroup = (CVAL('NETGROUP'))
SET VAR vNetLocalGroup = (CVAL('NETLOCALGROUP'))
SHOW VAR

Variable                         = Value                               
   Type
--------------------------------   ------------------------------      
   -------
vNetGroup                        = None                                
    TEXT    
vNetLocalGroup                   = Administrators                      
    TEXT    

10 Alternative Toolbar Layout for Designers

In order to consolidate the many Form Designer Control Toolbars into a single toolbar for better
screen use, a new option is now available within the Form Properties to do so.
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After enabling the setting, the Standard Controls, Database Controls, Variables Controls,
Additional Controls, Legacy Controls, Internet Controls, and File System Controls toolbars are
consolidated on one single toolbar palette.

The "Use Consolidated Control Palette" setting is also available within the Report/Label
Designers.
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After enabling the setting, the Standard Controls, Database Controls, Variables Controls,
Advanced Controls, and PDF Form Controls toolbars are consolidated on one single toolbar
palette.

11 Context Help for Form, Report, and Label Designers

The Form, Report, Label, and External Form Designers have been enhanced to support the
ability to launch the specific chapter within the Help documentation directly from a selected
object or control. This time saving allows for fast reference to the documentation for some
controls that seem buried within chapters of pages.

For form controls, an added button is located on the bottom left corner of every properties
dialog.
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For report and label controls, an added option is located on the bottom of every menu when
you right click on the control. Pressing [Shift]+[F1] while the control is selected will also launch
the Help chapter for the specific control.
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12 Single Click Form Object Conversions

Several Form Designer controls are listed twice, as the standard version and as an "Enhanced"
version (i.e Panel and the Enhanced Panel). The original control remains available for
backwards compatibility for those converting from pre-9.x releases. In previous versions, in
order to take advantage of the "enhanced" control, the form object would need to be recreated
on the form to replace the original. 

With R:BASE eXtreme 9.5, an additional option is available for each object that has an
"Enhanced" version, when a user right clicks on it within the Form Designer. The list of controls
are as follows:

Panel > Convert to Enhanced Panel
Group Box > Convert to Enhanced Group Box
Speed Button > Convert to Enhanced Speed Button
Tab Control > Convert to Enhanced Tab Control
Variable Calendar > Convert to Enhanced Variable Calendar
Variable Rich Edit -> Convert to Advanced Variable Rich Edit
DB Calendar -> Convert to Enhanced DB Calendar
DB Grid > Convert to Enhanced DB Grid
DB Navigator > Convert to Enhanced DB Navigator
DB Rich Edit -> Convert to Advanced DB Rich Edit
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13 New Interface for Database Events

Users can utilize database events to run a command file whenever a database is connected or
packed. Access to the database events is now available within the Configuration Settings
dialog.

Database Events:

ON ERROR
BEFORE PACK
AFTER PACK
BEFORE CONNECT
AFTER CONNECT
FIRST CONNECT
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A common use would be to run a command file that does an AUTOCHK command before
connecting. The ABORT ON command could then be used to cause the CONNECT/PACK to be
aborted after the command file finishes. 

14 Additional "Apply" Button for Form Control Properties

On each form control, an additional "Apply" button has been added with "OK" and "Cancel" for
all property dialog windows. This permits the changes to be seen on the form without exiting
the properties dialog. 



What's eXclusive to R:BASE eXtreme 9.5 for Windows20

Copyright © 1982-2016 R:BASE Technologies, Inc.

15 Form Control "Locks" are Saved within the Form

Form Controls can be locked to prevent accidental changes to their properties. To do so, right
click on the control(s) and select "Lock Control" from the menu. This feature has been
supported in previous versions, but the "lock" was only active for that Form Designer instance.

In R:BASE eXtreme 9.5, the lock setting is now saved with the form, so when the form is
launched in the designer at a later time, the control(s) are still locked.

Normally, when a control is selected, the blue handlebars appear on the corners and sides of
the control.
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If a selected control is locked, the handlebars will be gray.
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16 DIALOG Command Enhancements

Input Font
Four new parameters are available to customize the font name, font color, font size, and
background color for the input field of the DIALOG message window.

INPUT_FONT_NAME 
INPUT_FONT_COLOR 
INPUT_FONT_SIZE
INPUT_BACKGROUND_COLOR

Using the following DIALOG syntax;

DIALOG 'Please enter last name to search:' vResponse vEndKey  1  +
CAPTION 'DIALOG Window' ICON INFO +
OPTION MESSAGE_FONT_COLOR 2147483647 +
|INPUT_FONT_NAME Tahoma + 
|INPUT_FONT_COLOR RED + 
|INPUT_FONT_SIZE 12 +
|INPUT_BACKGROUND_COLOR 9234160 +
|MESSAGE_BOLD ON

a DIALOG window will use a customized font for the field text.

Cursor Position 
A new CURSOR_POS parameter has been added to the DIALOG command to place the cursor
at any position for the specified text in the edit field.

Using the following DIALOG syntax;

SET VAR vResponse TEXT = 'Thank you'

DIALOG 'Message ...' vResponse vEndKey  1  +
CAPTION 'DIALOG Window' ICON INFO +
OPTION MESSAGE_FONT_COLOR 2147483647 +
|MESSAGE_BACK_COLOR -16777201+
|MESSAGE_FONT_NAME Tahoma+
|MESSAGE_FONT_SIZE 10+
|MESSAGE_BOLD ON

a DIALOG window will displays as follows, with the cursor located at the beginning of the text
field.
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With the CURSOR_POS parameter, the following DIALOG syntax can be used to place the
cursor at the 6th position of the field.

SET VAR vResponse TEXT = 'Thank you'

DIALOG 'Message ...' vResponse vEndKey  1  +
CAPTION 'DIALOG Window' ICON INFO +
OPTION MESSAGE_FONT_COLOR 2147483647 +
|MESSAGE_BACK_COLOR -16777201+
|MESSAGE_FONT_NAME Tahoma+
|MESSAGE_FONT_SIZE 10+
|MESSAGE_BOLD ON+
|CURSOR_POS 6

The following DIALOG syntax places the cursor at the end of the field.

SET VAR vResponse TEXT = 'Thank you'
DIALOG 'Message ...' vResponse vEndKey  1  +
CAPTION 'DIALOG Window' ICON INFO +
OPTION MESSAGE_FONT_COLOR 2147483647 +
|MESSAGE_BACK_COLOR -16777201+
|MESSAGE_FONT_NAME Tahoma+
|MESSAGE_FONT_SIZE 10+
|MESSAGE_BOLD ON+
|CURSOR_POS 9



What's eXclusive to R:BASE eXtreme 9.5 for Windows24

Copyright © 1982-2016 R:BASE Technologies, Inc.

 

17 Load Defaults for Configuration Settings

A "Defaults" button has been added to the Configuration Settings dialog box to restore the
default settings for the R:BASE environment. 

18 Additional Data Dictionary Features

New features have been added to the Data Dictionary, to increase productivity.

A "Multi-line Tabs" button has been added to the Data Dictionary to allow for the display of all
available tabs. 
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When browsing the contents of the "Columns" tab, a drop down box is available to limit the
available items of columns in just table or views. When "Tables" or "Views" is selected, the
selection will be stored to streamline use at a later time.
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When a computed column is displayed in the Data Dictionary, the ability to copy the entire
column definition or just the formula is available by right clicking on the displayed computed
column calculation in the Data Dictionary window.
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19 New Enhanced DB Grid Hot Key Features

Several hot key features have been added to the Enhanced DB Grid control to allow advanced
searching, filtering, column hiding, and multi-column sorting for the grid records. Dialog windows
can be launched using hot keys or by using the PROPERTY command. 

01. Record Search 
The Enhanced DB Grid supports "Record Search" capabilities that can be launched while running
the form.
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Hot Keys Syntax
[Ctrl + F] PROPERTY <Component ID> SHOWFINDDIALOG 'TRUE'

 A progress dialog will now be displayed during the search process, so the user knows the
search is working.

02. Filter Setup 
The Enhanced DB Grid allows a filter to be created to limit the displayed rows, with many
available conditions for specific results. 
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Hot Keys Syntax
[Ctrl + L] PROPERTY <Component ID> SHOWFILTERDIALOG 'TRUE' 

Capture the WHERE Clause
After the "Filter Setup" is launched and conditions are selected for the Enhanced DB Grid,
the GETPROPERTY command can be used to return the current filter as a WHERE Clause.
This is helpful if the current record set needs captured for export, report output, or used
elsewhere.  

GETPROPERTY TABLE TableName->FILTEREDWHERE vVarName

03. Show/Hide Columns 
The columns headers of the Enhanced DB Grid can be hidden/displayed and rearranged. The
check boxes control whether a column is displayed. The arrow buttons on the dialog are used
to possibly reorder the columns.
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Hot Keys Syntax
[Ctrl + S] PROPERTY <Component ID> SHOWCOLUMNDIALOG 'TRUE' 

04. Multi-Column Sorting
One or more of the Enhanced DB Grid columns can be sorted in either ascending or descending
order. 
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Hot Keys Syntax
[Ctrl + D] PROPERTY <Component ID> SHOWSORTDIALOG 'TRUE'

20 Tree View Search Functionality

The Tree View and DB Tree View controls now support the ability to search the nodes for text.
This functionality is beneficial to the users where a Tree View contains many nodes with several
levels. 

Pressing [Ctrl] +[F] will display the following search dialog.
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The PROPERTY command FINDNODE parameter has also been introduced to allow searching
with the command syntax.

Example: 

PROPERTY TreeViewControl FINDNODE 'Analysis'

21 Copy/Paste Pop-up Menu Properties

The ability to copy and paste form "Pop-up Menu" properties has been added to the Form
Designer, allowing users to copy the following settings:

Title Color
Title Font
List Color
List Font
Number of Lines
Show Lines

To copy and paste Pop-up Menu properties, use [Ctrl]+[Alt]+[C] to copy and [Ctrl]+[Alt]+[V] to
paste while previewing the "Pop-up Menus" tab of the DB Edit or Variable Edit control.
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The Pop-up Menu properties can now be easily moved from Pop-up Menu to Pop-up Menu, and
from form to form!

22 New UNLOAD STRUCTURE Functionality

The table UNLOAD functionality has been enhanced to allow the unloading of ODBC Server
Table and dBASE table structure. This enhancement is available from within the Database
Explorer as well as the UNLOAD command to use at the R> Prompt and within command files.
Server Table or dBASE tables can be unloaded individually or all at once.

The Server Table unload lists the SCONNECT and SATTACH commands used to create the
table(s). The dBASE Table unload lists the ATTACH commands used to attach the dBASE
table(s).
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UNLOAD Syntax for Server Tables:

UNLOAD STRUCTURE FOR SERVER_TABLES

SCONNECT 'Bluzvan_RBG91_32'
SATTACH MusicType USING +
  MusicType  

SCONNECT 'Bluzvan_RBG91_32'
SATTACH Albums USING +
  Album_ID , +
AlbumTitle , +
ReleaseDate , +
RecordLabel , +
Artist_ID , +
MusicType , +
Commentsl   ALIAS +
 Album_ID , +
 AlbumTitle , +
 ReleaseDate , +
 RecordLabel , +
 Artist_ID , +
 MusicType , +
 Commentsl

UNLOAD Syntax for dBASE Tables:

UNLOAD STRUCTURE FOR dBASE_TABLES

ATTACH ISSUE
ATTACH RCETYPE
ATTACH DCAMP234

The same output will be generated when using the right click "Unload" menu option within the
Database Explorer.
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23 Pop-up Menu in Default Form Settings

A "Pop-up Menus" tab has been added to the Default Form Settings for the Form Designer to
assign a default values for all new pop-up menus added to forms. 

Lines 
Number of Lines

Limits the number of
values displayed in the
Pop-up Menu
Show Lines

Displayed lines between
the values in the Pop-up
Menu

Title Background Color
and Font

Specifies the background
color of the title
AaBbYyZz 

Specifies the font style,
size and color for the title

List  Background Color
and Font

Specifies the background
color of the list
AaBbYyZz 

Specifies the font style,
size and color for the list

 

24 Drag Form Property for Enhanced Panels

A “Drag Form” property for the Enhanced Panel has been added to allow a user to drag a form
by holding a left mouse button on the panel. The allows the user to move the form around the
screen even if the form does not have a caption bar. By default, the property is false.
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25 New "Copy Database to..." option

An additional "Copy Database to..." menu option is available when a right click is made on a
database within the Database Explorer. This allows for easier file maintenance for database
administrators in allowing the ability to copy the files to another folder and maintain the familiar
names.
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The database must be disconnected in order to copy the files. 

26 New Favorites Toolbar for Form/Report Designers

The Favorites Toolbar allows users to customize their favorite controls onto a single toolbar
that lists their commonly used items. Select "View" > "Favorites" from the main Menu Bar to
open the "Favorite Controls" dialog.
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For the Form Designer, Favorites can be pulled from Standard, Database, Variables, Additional,
Legacy, Internet, and File System Controls. For the Report/Label Designer, Favorites can be
pulled from Standard, Database, Variables, Advanced, and PDF Report Controls. The "Other"
selection allows for a separator to be added to the Favorites toolbar. The controls can be
sorted in a desired order as well. 

After populating a list of favorites, select "View" > "Toolbars" > "Favorites" to enable the
display of the new customized toolbar.

27 New Margins Setting for Form Controls

The Margins setting for form controls allows for spacing to be added for controls which are set
as "aligned". The combined implementation of alignment and margins for controls maintains the
layout for a form after being resized and adds to the form aesthetics.

In the properties for each control, the "Align" property is available within the "Size and
Coordinates" panel. 
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The options include:

None  - Object can be moved anywhere because it is not aligned to the parent object
Client - Aligns itself to the available client area by expanding to fill the parent object that
it is in
Left - Aligns itself to the left side of the parent object growing or shrinking to match
parent height
Right - Aligns itself to the right side of the parent object growing or shrinking to match
parent height
Top - Aligns itself to the top side of the parent object growing or shrinking to match
parent width
Bottom - Aligns itself to the bottom side of the parent object growing or shrinking to
match parent width

In the following form example, an Enhanced Panel is located on a form and is "top" aligned. 

To set the margins for a control, select "Layout" > "Margins" from the main Menu Bar. The "Align
with Margins" check box must be checked.



What's eXclusive to R:BASE eXtreme 9.5 for Windows40

Copyright © 1982-2016 R:BASE Technologies, Inc.

With the margins set to 15 pixels on each side, the panel will display spacing on all sides. 

A second panel added to the form that is top aligned would have the left, right, and bottom
margins set, and the top would be set to zero. 

The second Enhanced Panel's margins maintains the same spacing to match the first panel. 
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28 Additional "Find in Files" Settings

The "Find in Files" utility allows users to locate command files based upon specific text within
the files. New options allow the search for text to be more precise. 

Search criteria can be modified based on file extensions, case sensitivity, subdirectory
searches, and file attributes. A "Skip Files" field allows the exclusion of files from the text
search. The search dialog will launch with the previously used options, along with a combo box
with the last ten searched items.

After the search is complete, the selected files can be opened in the R:BASE Editor.
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29 Variable Form to External Form Conversion

A new feature in the Database Explorer within the "Forms" options allows for a Variable Form
to be saved as an External Form File. The option is only enabled when a Variable Form is
selected. 
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A dialog prompts for the External Form File name with the .rff file extension.
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30 Truncated Data Warning for the Data Designer

When modifying definitions for TEXT data type columns, and after decreasing the length value,
a warning message will be displayed describing the changes. This warning will help prevent
data values for the displayed column from being truncated when saving the table.

Changes to multiple will also be displayed.

31 Autosize Buttons for the DB Navigator

The Enhanced DB Navigator control supports the ability for the buttons to be resized
automatically. 
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This features allows users to add the Enhanced DB Navigator to forms, and maintain the same
button sizes used in the original DB Navigator control. 

If a DB Navigator control exists on a form, be sure to convert it to an Enhanced DB Navigator,
right clicking on the items and selecting "Convert to Enhanced DB Navigator". When doing so,
the "Autosize Buttons" attribute will be set to true.
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32 New R> Prompt Enhancements

Command History Panel
The Command History panel permanently displays the buttons that are available with a right
click in the panel
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Paste File Names
With a file or files added to the Windows clipboard, the file names can be pasted to R> Prompt.

33 Enhanced Image Support for Drop Down Menu and Bit
Buttons

Load from Icon File
The Drop Down Menu Button and Bit Button permit the ability to load a glyph from an
executable, dynamic link library (DLL), OCX file, or icon file (.ICO). A 32x32 or 16x16 pixel glyph
can be displayed.

Alpha Channel Support
The Drop Down Menu Button and Bit Button now provide alpha channel support to display a
greater level of transparency for glyphs used on the buttons. A new attribute "Blend Image"
allows this capability. The highest benefit of using alpha channel is visual appeal. Without alpha
channel support, images would have a blocky jagged edge to them, like displayed below for the
button on the left. This allows for the buttons to support PNG images in addition to BMP.
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34 Additional LAUNCH command parameters

The LAUNCH command supports several new parameters for operating system operations and
show modes for the launched program. 

Operations
New operation parameters allow for parts of the operating system to be utilized within R:BASE.

CMD_EXPLORE - displays the Windows Explorer from the specified folder 
CMD_FIND - initiates a search from the specified folder 
CMD_PRINT - prints a file to the default printer, or displays a print dialog, based upon
file type

Examples:

LAUNCH CMD_EXPLORE|C:\RBTI

LAUNCH CMD_FIND|F:\DATA

LAUNCH CMD_PRINT|C:\ReadMe.txt

Show Modes
Several show modes are available for the launched program or operation.

NORMAL - launches the program in a normal window
MINIMIZED - launches the program in a minimized window
MAXIMIZED - launches  the program in a maximized window
HIDE - launches the program, but it is hidden from display

Examples:

LAUNCH C:\MyDocs\ReadMe.txt |||NORMAL

LAUNCH 'winword|"C:\My Documents\AllFiles.docx" "/mMacroName"|W' |
MAXIMIZED
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LAUNCH C:\MyDocs\ReadMe.txt |||MINIMIZED

LAUNCH CMD_PRINT|N:\Sales\OrderForm.pdf ||HIDE

35 New RNDDOWN Function

The RNDDOWN function returns a number rounded down to a specified number of digits.

Syntax:

(RNDDOWN(number,digits))

Where:

number is the number to round down
digits is the number of digits to round the number down to

Remarks:

RNDDOWN behaves like ROUND, except that it always rounds a number down. 
If digits is greater than 0 (zero), then number is rounded down to the specified
number of decimal places. 
If digits is 0, then number is rounded down to the nearest integer. 
If digits is less than 0, then number is rounded down to the left of the decimal point. 

Examples:

--Example 01:
SET VAR v1 DOUBLE = (RNDDOWN(662.79,0)) 
SHOW VAR v1 
662 

--Example 02:
SET VAR v2 DOUBLE = (RNDDOWN(662.79, 1))
SHOW VAR v2
662.7

--Example 03:
SET VAR v3 DOUBLE = (RNDDOWN(54.1, -1))
SHOW VAR v3
50 

--Example 04:
SET VAR v4 DOUBLE = (RNDDOWN(55.1, -1))
SHOW VAR v4
50 

--Example 05:
SET VAR v5 DOUBLE = (RNDDOWN(-23.67, 1))
SHOW VAR v5
-23.6
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36 Cue Banner Display in DB/Variable Edit Fields

The cue banner displays a text hint that appears in the field, which provides another form of
instruction to end users. The cue banner is only available to DB Edit and Variable Edit fields.

Once the focus lands on the field, or when keystrokes are entered, the cue banner disappears.
An optional setting can be used so the hint remains until keystrokes are pressed (Windows
Vista, 7, and higher only).

The PROPERTY command can be used to specify the cue banner for the fields.
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PROPERTY DBUserName CUEBANNER 'User Name'
PROPERTY DB_Password CUEBANNER 'Password'

37 R:BASE On-Screen Keyboard (ROSK)

The R:BASE On-Screen Keyboard is a visual keyboard displayed on the screen that allows users
to type and enter data, instead of relying on a physical keyboard. With all standard keys
displayed, users can select keys using the mouse or another pointing device. The PROPERTY
command can used to customize the R:BASE On-Screen Keyboard button font color, button
background color, button edge, background color, screen location, and window caption. The
keyboard can also be resized by dragging window sides. When altered, the size and position is
preserved between sessions.

The keyboard is accessible using the following methods:

1. Selecting "Utilities" > "On Screen Keyboard" from the main Menu Bar
2. Pressing the [Ctrl]+[Alt]+K key combination
3. Using the PROPERTY command

Important Note:

The R:BASE On-Screen Keyboard is only supported on Windows 7, 8.x, Windows 2008
Server R2, and higher operating systems.

PROPERTY Commands

--To show/hide the keyboard
PROPERTY ROSK SHOW TRUE/FALSE

--To alter the type of keyboard 
PROPERTY ROSK TYPE ALPHA/NUMPAD

--To alter the screen location of the keyboard
PROPERTY ROSK LEFT Value
PROPERTY ROSK TOP Value

--To alter the screen size of the keyboard
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PROPERTY ROSK HEIGHT Value
PROPERTY ROSK WIDTH Value

--To alter the caption of the keyboard window
PROPERTY ROSK CAPTION 'Value'

--To alter the color of the button outer edge:
PROPERTY ROSK OUTER_EDGE_COLOR_NORMAL Value
PROPERTY ROSK OUTER_EDGE_COLOR_PRESSED Value
PROPERTY ROSK OUTER_EDGE_COLOR_DISABLED Value

--To alter the color of the button inner edge:
PROPERTY ROSK INNER_EDGE_COLOR_NORMAL Value
PROPERTY ROSK INNER_EDGE_COLOR_PRESSED Value
PROPERTY ROSK INNER_EDGE_COLOR_DISABLED Value

--To alter the starting gradient color of the button background:
PROPERTY ROSK BK_START_COLOR_NORMAL Value
PROPERTY ROSK BK_START_COLOR_PRESSED Value
PROPERTY ROSK BK_START_COLOR_DISABLED Value

--To alter the ending gradient color of the button background:
PROPERTY ROSK BK_END_COLOR_NORMAL Value
PROPERTY ROSK BK_END_COLOR_PRESSED Value
PROPERTY ROSK BK_END_COLOR_DISABLED Value

--To alter the font colors of the buttons:
PROPERTY ROSK TEXT_COLOR_NORMAL Value
PROPERTY ROSK TEXT_COLOR_PRESSED Value
PROPERTY ROSK TEXT_COLOR_DISABLED Value

PROPERTY ROSK DRAWING_STYLE NORMAL / GRADIENT
PROPERTY ROSK GRADIENT_START_COLOR Value
PROPERTY ROSK GRADIENT_END_COLOR Value

Example:

PROPERTY ROSK SHOW TRUE
PROPERTY ROSK TYPE ALPHA
PROPERTY ROSK LEFT 50
PROPERTY ROSK TOP 50
PROPERTY ROSK CAPTION 'Making the impossible possible!'

PROPERTY ROSK BK_START_COLOR_NORMAL WHITE
PROPERTY ROSK BK_END_COLOR_NORMAL RED

PROPERTY ROSK BK_START_COLOR_PRESSED white
PROPERTY ROSK BK_END_COLOR_PRESSED GRAY

PROPERTY ROSK OUTER_EDGE_COLOR_NORMAL BLACK
PROPERTY ROSK OUTER_EDGE_COLOR_PRESSED RED

PROPERTY ROSK INNER_EDGE_COLOR_NORMAL WHITE
PROPERTY ROSK INNER_EDGE_COLOR_PRESSED RED
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PROPERTY ROSK TEXT_COLOR_NORMAL BLACK
PROPERTY ROSK TEXT_COLOR_PRESSED BLACK

PROPERTY ROSK DRAWING_STYLE GRADIENT
PROPERTY ROSK GRADIENT_START_COLOR BLUE
PROPERTY ROSK GRADIENT_END_COLOR WHITE

38 Balloon Tip Hint in DB/Variable Edit Fields

The balloon tip displays a hint message that can be used in response to an end user action on
the form, or even to a specific form object. The balloon tip will appear when the
SHOWBALLOONTIP parameter is set to TRUE for the field's Component ID. A title, message, and
icon image can be displayed in the balloon tip. The balloon tip is only available to DB Edit and
Variable Edit fields.

Icon options available include:

None   
Info (bttiInfo)
Warning
Error
Info Large  (Windows Vista, 7, and higher only)
Warning Large  (Windows Vista, 7, and higher only)
Error Large  (Windows Vista, 7, and higher only)

Sample:

PROPERTY PEdit_PO BalloonTipTitle 'Attention'
PROPERTY PEdit_PO BalloonTipText 'A Purchase Order Number is
Required.'
PROPERTY PEdit_PO BalloonTipIcon Info
PROPERTY PEdit_PO ShowBalloonTip TRUE
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39 New BLOB Editor Multi-Page Image Features

The R:BASE BLOB Editor now supports additional functionality when working with multi-page
images. An new "Add Image from File" option has been added to place a image file at the end
of the list. This enhances the existing ability to insert an image file within a file list. 

Two new navigation options are also available to moves the selected images up and down
within the file list.
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40 Comment and Version for External Form Files

Database Explorer support to store and display "Comment" and "Version" information for
External Form Files has been implemented. 

41 Column Comment Hints in WHERE/Expression Builders

The WHERE Builder and Expression Builder windows now include a "Display Column Comments"
button option that will display the comment as a hint. This allows for greater understanding of
the column purpose if the name is not descriptive enough.
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42 Clear Error List in Trace Debugger

In the Trace Debugger, an Error List Toolbar is available to display programming errors that
occur during code debugging. If the Error List becomes too populated, there was no method to
clear the list without restarting R:BASE. Now, a new menu option is available to clear the error
list.

From the Menu Bar, choose "Errors" > "Clear Error List" 
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43 Character Case for Report Memo Objects

The Report Designer Memo Controls (Variable Memo, DB Memo, Memo) have been enhanced to
support the "Character Case" setting, which forces the character case of the text lower case or
upper case. The setting changes the appearance of the displayed text and not the actual text.
The setting can be set to Normal to remove the character case.



Character Case for Report Memo Objects 59

Copyright © 1982-2016 R:BASE Technologies, Inc.

44 RBA Application File Conversion

Within the External Form File portion of the Database Explorer, the new "Convert
Application(s)..." option is available to convert R:BASE application files (.RBA) to an External
Form File. The .RBA application files are menu systems that were created in R:BASE versions 7.0
and higher.
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Selecting this option will create an external form that matches the same properties used within
the RBA application file.

When the external form file is created, the "Main Menu" section is converted to a form "Menu
Bar", the "Actions" are converted to "Custom Form Actions", and the "Toolbar" is converted to a
toolbar in the new "Toolbar Designer". 

45 Toolbar Designer

The Toolbar Designer the area within an R:BASE form for building a custom Toolbar, associating
Popup Menus to the Toolbar buttons, and alter the display of the Toolbar on the form.
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Caption - specifies the Toolbar button text
Component ID - specifies the unique identifier used when passing property parameters in
statements 
Hint - specifies the Toolbar button hint
Custom Form Action- specifies the Custom Form Action that runs when the Toolbar button is
selected
Popup Menu - specifies the Popup Menu that "drops down" when the Toolbar button is selected

Add Button - adds a button to the Toolbar. Button types include:

Button - button that can display an image with or without a caption
Separator- appears as a line on the toolbar (to separate other controls)
Drop-Down Button - displays a downward-pointing arrow
Text Button - can appear with the caption only, when the "List" property is checked

Delete - deletes the currently selected button
Clear All - clears all buttons

Notes:

Buttons can be assigned images stored within the Image List Editor. Right click on the
button to assign an image.
To add a separator to a list of buttons, place a new button, right click on it, and set the 
Button Type to "Separator".

The Toolbar Properties alter the display of the Toolbar on the form.
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Position - determines the position of the Toolbar on the form

Other
Allow Text Buttons - determines whether tool buttons that consist only of text can be placed on
the Toolbar
Flat - makes the toolbar transparent and eliminates tool-button borders
Hide Clipped Buttons - specifies handling of buttons obscured by an adjacent toolbar
List - aligns captions on the right and images on the left in tool buttons
Show Captions - determines whether text captions are displayed on tool buttons
Transparent - specifies whether the toolbar is transparent
Wrapable - enables automatic line-wrap for components in the toolbar

Drawing Style - determines the drawing style type

Gradient Drawing Options - determines the gradient drawing option

Gradient Direction - specifies whether the direction of the gradient is horizontal or vertical

Colors
Gradient Start Color - color used as start color for the gradient
Gradient End Color - color used as end color for the gradient
Hot Track Color - color used as hot tracking color when in gradient style 

Border
Inner Edge - determines the border style for the toolbar's inner edge
Outer Edge  determines the border style for the toolbar's outer edge
Border Width - specifies the width of the tool bar's border
Indent - specifies the margin on the left side of the toolbar
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Edge Borders - determines which sides of the toolbar have borders

46 Popup Menu Designer

The Popup Menu Designer is the interface to create popup up menus for a Toolbar on an
R:BASE form. This interface is not to be confused with Pop-up Menus that are used with DB Edit
and Variable Edit controls, where a table-driven pop-up "dialog" menu is displayed. 

The Popup Menu is basically the portion of the Toolbar that "drops down" from the toolbar
when a button is selected. The list of items contained within the Popup Menu are a group of
Actions, selected from your list of available Custom Form Actions that were created in the
earlier stages of the application's design, and then assembled into a single module. 

Add  - adds a Popup Menu
Delete - deletes the currently selected Popup Menu

Text - specifies the Menu Item text
Component ID - specifies the unique identifier used when passing property parameters in
statements 
Hint - specifies the Menu Item hint
Custom Form Action- specifies the Custom Form Action that runs when the Menu Item is
selected

Add Item - adds an Item to the Popup Menu
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Add Sub-Item - adds a Sub-Item to the currently selected Menu Item
Delete - deletes the currently selected Menu Item
Clear All - clears all Menu Items for the currently selected Popup Menu

Notes:

Menu Items and Sub-Items can be assigned images stored within the Image List Editor.
Right click on the Menu Item to assign an image.
To add a separator to a list of Menu Items or Sub-Items, place a hyphen within the "Text"
field.
A tree of Popup Menu Items and Sub-Items can be build with any number of levels deep. 

Example:

By selecting "View" from the Form Designer main Menu Bar, the following Popup Menu is
provided in a menu tree format. 

Any of the items can be selected to run an action, and one (Toolbars) displays a list of sub-
items. The image above is an example of a single Popup Menu with 6 actions assigned to it.

47 Image List Editor

The Image List Editor is a storage location for image files to be used within the Menu Bar
Designer, Popup Menu Designer, Toolbar Designer, and in Custom Form Actions. 
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The Image List Editor can only store one image size (i.e 16x16, 32x32, etc.) at a time. 

48 New Image Folder System Variable

A new RBTI System Variable, RBTI_IMG_FOLDER, is now supported to define a default folder
path where all "Open Image" dialogs will initially start.

SET VAR RBTI_IMG_FOLDER TEXT = 'C:\TEMP\IMAGES\'
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Notes:

The RBTI_IMG_FOLDER System Variable must be redefined for a new session of R:BASE,
so define the variable in your development startup file.

If the RBTI_IMG_FOLDER variable does not exist or contains a non-valid folder path, all
image dialogs will open in the current folder.

49 Duplicate Row in Data Browser/Editor

In the Data Browser/Editor, an additional "Duplicate Row" option [Ctrl+F2] has been added to
insert a duplicate row of the current row.  

The option is also available by selecting "Edit" > "Duplicate Row" from the main Menu Bar.

50 DROP Multiple Views

The DROP command has been enhanced to drop multiple views with the same DROP command.

DROP VIEW ViewName1, ViewName2, ViewName3 

DROP VIEW ViewName1, ViewName2, ViewName3 NOCHECK
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51 Capture a Report Page Number

A new GETPROPERTY command parameter is available to utilize within reports that will return
the current page number.

GETPROPERTY REPORT PAGENO VarName

Example:

SET VAR vPageNumber TEXT = NULL
GETPROPERTY REPORT PAGENO 'vPageNumber'
PAUSE 2 USING .vPageNumber
RETURN

52 New Spinner Controls

The new DB Spinner and Variable Spinner Form Controls has been added to Form Designer to
scroll integer values. The control is similar to the Spin Edit control, but offers  different display
and more control of the value stored in the control.

The DB Spinner and Variable Spinner Form Controls are available.

53 Modal External Form Designer

The DEFF command includes the MODAL option, so an external form file can be modified within
an application.

filename.rff
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Specifies the name of the external form file.

MODAL

Allows an EEP command block to launch an existing external form in the designer. Specifying a
new file name will create a new external form. After making appropriate changes, the file can
be saved. The designer must be closed in order to continue the next command in the EEP.

54 Enhanced LIST Command

The LIST command has been enhanced with several additional parameters to display tables
and how they are in use within R:BASE, along with additional information for forms, reports,
and labels.

01.
The LIST command supports a new parameter to list only dBASE tables. 

R>LIST TABLES dBASE

Number of Tables in Database RRBYW18 is 76.
Number of Columns in Database RRBYW18 is 368.
Number of Indexes in Database RRBYW18 is 53.
Number of users connected: 1.
   Dbase Tables in the database RRBYW18

   Name                              Columns      Rows   Comments
   --------------------------------- ------- ---------  
---------------------------------
   clients                                25       DBF   clients.DBF
   country                                 2       DBF   country.DBF
   honey                                  10       DBF   honey.DBF
   rectype                                 2       DBF   rectype.DBF

02.
The LIST command supports a new parameter to list only Server tables.

 
R>LIST TABLES SERVER

Number of Tables in Database RRBYW18 is 75.
Number of Columns in Database RRBYW18 is 346.
Number of Indexes in Database RRBYW18 is 53.
Number of users connected: 1.
   Server Tables in the Database RRBYW18

   Name                              Columns      Rows   Comments
   --------------------------------- ------- ---------  
---------------------------------
   TransDetail                             6    SERVER   Server table
- TransDetail ConComp
   TransMaster                             8    SERVER   Server table
- TransMaster ConComp

03.
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The LIST command supports a new parameter to list only temporary tables.

R>LIST TABLES TEMP

Number of Tables in Database RRBYW18 is 74 permanent, 11 temporary.
Number of Columns in Database RRBYW18 is 344 permanent, 45 temporary.
Number of Indexes in Database RRBYW18 is 53 permanent, 8 temporary.
Number of users connected: 1.
   Temporary Tables in the Database RRBYW18

   Name                              Columns      Rows   Comments
   --------------------------------- ------- ---------  
---------------------------------
(T)BSTRDataType                            2         3   BSTR Data
Type
(T)TestImport                              1         0

04.
The LIST command supports a new parameter to list only locked tables.

R>LIST TABLES LOCK

Number of Tables in Database RRBYW18 is 73.
Number of Columns in Database RRBYW18 is 348.
Number of Indexes in Database RRBYW18 is 54.
Number of users connected: 1.
   Locked Tables in the Database RRBYW18

   Name                Columns      Rows   Comments
   ------------------- ------- ---------  
---------------------------------
(L)Component                 2        12   Component Identification
Number and 
                                           Description
(L)Customer                 17        31   Customer Information
(L)Levels                    3        40   Pricing Level Per Model by
Percent
(L)ProdLocation              5        20   Product Location, Quantity
on Hand, 
                                           and Cost

05.
The LIST command will now provide the date/time stamp and version for forms, reports, and
labels. This enhancement is specific to R:BASE eXtreme 9.5 (64).

R>LIST FORM FOR EMPLOYEE

   Form                             Table / View                    
Form Description                         Modified            Version
   -------------------------------- --------------------------------
---------------------------------------- ------------------- --------
   DBGridProperties                 Employee                        
To Demonstrate the DB Grid               05/11/2012 10:13 AM        1
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   DBGridWithPickList               Employee                        
To Display DBGrid with Pick List         05/11/2012 10:13 AM        1
   Employees                        Employee                        
Enter/Update Employee(s)                 05/11/2012 10:13 AM        1
   Employees_Test_DBEdit_Read_Only  Employee                        
Enter/Update Employee(s)                 05/16/2013 12:17 PM        5
   Employees_Test_DBEdit_RO_        Employee                        
Enter/Update Employee(s)                 05/22/2013  2:21 PM       24
   RBG9_CapturingIma                Employee                        
Capturing Images with the DB Image       05/11/2012 10:13 AM        1
 
R>LIST REPORTS FOR CONTACT

   Report                           Table / View                    
Report Description                       Modified            Version
   -------------------------------- --------------------------------
---------------------------------------- ------------------- --------
   Contacts                         Contact                         
Customer Contact List                    05/11/2012 10:13 AM        1
   ContactsByCustomer               Contact                         
Contact List by Customer                 05/11/2012 10:13 AM        1
   RBG9_AdvRichText                 Contact                         
Advanced Rich Text Report                05/11/2012 10:13 AM        1
   RBG9_RptSysVars                  Contact                         
New Report System Variables              05/11/2012 10:13 AM        1

55 Additional Character Case Options

Two additional Character Case options have been added to Form Designer DB Edit and Variable
Edit Controls; 

Title Case - First letter of every word is capitalized
Sentence Case - First letter is capitalized)
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The two new Character Case options have also been added to the Report Designer DB Label,
Variable Label, and Label Controls, as well as the DB Memo, Variable Memo, and Memo
Controls; Title Case and Sentence Case
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56 Enhanced REFF Command

The REFF command, to run an external form file, has been enhanced to support the AS ALIAS
and CAPTION parameters.

filename.rff
Specifies the name of the external form file to launch.
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MDI 
Specifies a modeless form, allowing users to access other windows without closing the form
first. This option is used in R:BASE for Windows only.

AS alias 

This option is used in R:BASE for Windows only. Allows the user to specify a name for this
instance of the form. This option is used in conjunction with the MDI option so that the user can
programmatically specify the form with the SETFOCUS command.

CAPTION 'windowcaption' 

This option is used in R:BASE for Windows only. Specifies a caption for the window title bar.

Examples

REFF RRBYW18.RFF CAPTION 'Running R:BASE Your Way!'

REFF AdhocReports.RFF MDI AS Adhoc CAPTION 'Adhoc Custom Reports'

57 Enhanced ATTACH Command

The ATTACH command has been enhanced to support an alias name for the table and columns,
and to specify if the table is temporary. The ability to specify an alias name streamlines the
attaching of dBASE files that contain reserved words for the file name and columns.

Options

ALIAS AliasList
To specify alias names for columns.

AS tablealias 
Specifies an alias, or temporary name, for the dBASE table. A table alias is sometimes required when
attaching files that do not follow the same table name restrictions as R:BASE.

filespec 
A dBASE database name with a drive and path specification in the form D:\PATHNAME
\FILENAME.

ndxlist 
Specifies a list of index files to associate with the specified dBASE file. You do not have to
include the extension for each index file. Separate index file names with a comma (or the
current delimiter). Index files must be located with the specified dBASE file.

TEMPORARY 
Allows you to create a temporary table with the ATTACH command. The temporary tables will disappear
when the database is disconnected. 

USING 
Removes dBASE index files that were previously associated with the attached dBASE file when
this option is used without a list of index files.

Example
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ATTACH TEMPORARY filename.dbf AS TableName ALIAS Column1, Column2,
Column3, Column4, Column5 

58 Additional Logical Functions

Several additional logical functions have been added to R:BASE to assist with performing
calculations.

01.
(IFLE(arg1,arg2,arg3,arg4))

If arg1 is less than or equal to arg2, IFLE returns the value of arg3. If arg1 is greater than arg2, IFLE
returns the value of arg4. The data types of arg1 and arg2 must match and the data types of arg3 and
arg4 must match.

In the following example, the value of vifle is 100, since A is less than B.

SET VAR A = 37
SET VAR B = 48
SET VAR vifle = (IFLE(.A,.B,100,100))

02.
(IFGE(arg1,arg2,arg3,arg4))

If arg1 is greater than or equal to arg2, IFGE returns the value of arg3. If arg1 is less than arg2, IFGE
returns the value of arg4. The data types of arg1 and arg2 must match and the data types of arg3 and
arg4 must match.

In the following example, the value of vifge is 4, because the date 01/10/2013 is greater than the date
10/15/2012.

SET VAR vifge = (IFGE('01/10/2013','10/15/2012',4,5))

03.
(IFNE(arg1,arg2,arg3,arg4))

If arg1 and arg2 are not equal, IFNE returns the value of arg3. If arg1 and arg2 are equal, IFNE returns
the value of arg4. The data types of arg1 and arg2 must match and the data types of arg3 and arg4 must
match.

In the following example, the value of vifne is 7, since v1 is not equal to v2.

SET VAR v1 = 25
SET VAR v2 = 30
SET VAR vifne = (IFNE(.v1,.v2,7,8))

59 Enhanced RBBEDIT Command

Use the RBBEDIT command to start the R:BASE BLOB Editor, with which you can create or edit
binary files. 
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You can use the RBBEDIT command to launch the R:BASE BLOB Editor for managing external
files at the R> Prompt, in a command file, or in an EEP. Depending on the file extension, the
BLOB Editor will display the available options accordingly.

Options

filename.ext 

Specifies an external ASCII text, RTF, or image file. The R:BASE BLOB Editor recognizes the following
image formats: 

GIF BMP

DCX PCC

PCX AFI

VST TGA

PNG JPEG

JPG TIFF

TIF ICO

EMF WMF

ZoomMode
Specifies the zoom mode for the displayed image file

Zoom Parameter Description
ACTUAL zooms the image to the actual size
FULL fits the image to the full page of the BLOB Editor window
FIT_WIDTH fits the image to the current BLOB Editor window width
FIT_HEIGHT fits the image to the current BLOB Editor window height
FIT_PAGE fits the image to the current BLOB Editor window

DefaultTab
Specifies the default tab for the R:BASE BLOB Editor.

Default Tab Parameter
Image NOTE, VARCHAR, TEXT, NOTEVARCHAR
Note/Varchar IMAGE
Rich Text RICHTEXT, RTF
Unicode/BSTR UNICODEBSTR, UNICODE, BSTR
Hex HEX

Examples:

01.

The following will display the "Image" and "Hex" tabs of the BLOB Editor.

RBBEDIT 

02.

The following will display the image in the "Images" tab of the BLOB Editor in the full page zoom mode.
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RBBEDIT myphoto.bmp FULL IMAGE

03.

The following will display the "Rich Text" tab of the BLOB Editor. If the file exists it will be loaded. The
RICHTEXT parameter forced the "Rich Text" tab to be displayed.

RBBEDIT myfile.rtf RICHTEXT

04.

The following will display the text file in the "Note/VarChar" tab of the BLOB Editor.

RBBEDIT mytext.txt TEXT

05.
The following will display the a file in the "Unicode/BSTR" tab of the BLOB Editor.

RBBEDIT filename UNICODE

06.
The following will display the a file in the "Hex" tab of the BLOB Editor.

RBBEDIT filespec HEX

60 New RUNRBA Command

A new command, RUNRBA, is now supported to specifically run a .RBA application file which are
created specifically in the Application Designer. R:BASE will run an RBA file like it is run within the
Database Explorer, only from a command file or a Custom EEP.

filespec
Specifies the R:BASE application file to be run.

Example:

RUNRBA TestApp.rba

61 Persistent Space for Page Footer/Header Bands

Two new properties are supported for Page Footer and Page Header bands, "Persistent Space
On First Page" and "Persistent Space On Last Page", to determines whether the space
reserved for the band is kept, even if the contents are not printed.
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Persistent Space On First Page
Determines whether the space reserved for header or footer band is kept, even if the contents
are not printed

Persistent Space On Last Page
Determines whether the space reserved for header or footer band is kept, even if the contents
are not printed

62 New Selected Row Color Options for List Views

New "Selected Row Background and Font Color" options are available for the DB Lookup List
View and Variable Lookup List View controls. This feature provides highlighting color options for
the row when selected.
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The properties for the selected row can also be changed on the fly with the PROPERTY
command.

Example:

PROPERTY DBLULV_CompID SelectedBackgroundColor 'RED'
PROPERTY DBLULV_CompID SelectedFontColor 'WHITE'

63 New "On After Start" Action for RBA Application Files

A new "On After Start" Action was added to the Application Designer properties that specifies a
series of commands to run after the application main window is displayed.
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64 New IFF Function

A new IFF logical function has been added to handle working with conditions to return a value.

 IFF((condition), arg1, arg2)

If the condition is met, then the value of arg1 is returned. If condition is not met, then the value
of arg2 is returned. 

The condition must follow the syntax specifications as set with IF...ENDIF command structure.

The condition must list a set of conditions that combine to form a statement that is either true
or false. Conditions can be combined with the connecting operators AND, OR, AND NOT, and OR
NOT.  It is important to note that the condition needs to be a single item, which is why quotes
are used in the examples below. 

The data types of arg1 and arg2 must match. 

Examples:

-- Example 01:
- -Comparison of Variables

SET VAR v1 INTEGER = 1 
SET VAR v2 INTEGER = 2 
SET VAR v3 = (IFF('.v1<.v2','First','Second')) 
SHOW VAR v3
First

-- Example 02:
-- SELECT and Display Feedback on Data 
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CONNECT RRBYW18
R>SELECT NetAmount,(IFF('NetAmount>$100000','Good','Needs
Improvement'))=30 AS Status FROM SalesBonus

 NetAmount       Status                         
 --------------- ------------------------------ 
     $176,000.00 Good
      $87,500.00 Needs Improvement
      $22,500.00 Needs Improvement
      $40,500.00 Needs Improvement
      $76,800.00 Needs Improvement
      $36,625.00 Needs Improvement
      $56,250.00 Needs Improvement
     $152,250.00 Good
     $108,750.00 Good
      $78,750.00 Needs Improvement
      $27,000.00 Needs Improvement
       $9,500.00 Needs Improvement
     $210,625.00 Good

65 Support to Capture Images to the Clipboard

Capturing images is a functionality that R:BASE can perform from the Database Explorer as well
as using the PROPERTY command. In an R:BASE session, select "Utilities" > "Take a Snapshot"
> 

R:BASE Windows 
Whole Screen

Choosing either of these options will place the captured image to the clipboard, which can then
be pasted into an image editing program. 

With the PROPERTY command, R:BASE provides image capture functionality using the command
syntax. The two command parameters are: 

CAPTURE_FROM_SCREEN
CAPTURE_FROM_WINDOW

The parameters perform as their name implies, one capturing an image from the screen and the
other from the window.

PROPERTY RBASE_FORM 'CAPTURE_FROM_SCREEN|Left,Top,Right,Bottom'
filename 
PROPERTY RBASE_FORM 'CAPTURE_FROM_WINDOW|Left,Top,Right,Bottom'
filename

The optional pixel area can be specified to grab a limited area with the Left, Top, Right, and
Bottom pixel values. A file name can be specified for the image capture, using either JPEG or
BMP images file formats. If the .JPG or .JPEG file extension is specified, the image format will be
stored as JPEG. All other file extensions will be considered as the BMP file format.

Examples:

-- to capture the entire screen 
PROPERTY RBASE_FORM CAPTURE_FROM_SCREEN 'c:\Entire_Screen.jpg'
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-- to capture part of the screen 
PROPERTY RBASE_FORM 'CAPTURE_FROM_SCREEN|23, 24, 934, 800' 'c:
\Screen_Cap.jpg'

-- to capture the entire form 
PROPERTY RBASE_FORM CAPTURE_FROM_WINDOW 'c:\Entire_Form.jpg'

-- to capture part of a form 
PROPERTY RBASE_FORM 'CAPTURE_FROM_WINDOW|12,12,134,300' 'c:
\Form_Cap.jpg'

A new enhancement to R:BASE is the ability to use the current PROPERTY command to support
capturing an image of the current window or screen and place the content in the clipboard.

Examples:

  -- to capture the full form window to the clipboard
  PROPERTY RBASE_FORM CAPTURE_FROM_WINDOW CLIPBOARD

  -- to capture part of screen to to the clipboard
  PROPERTY RBASE_FORM 'CAPTURE_FROM_SCREEN|23, 24, 934, 800'
CLIPBOARD

66 Dynamic Enhanced DB Grid Column Sorting

Several new parameters allow for the columns of an Enhanced DB Grid to be sorted. The 
SORTASC property can be used to sort the column in ascending order. The SORTDESC
property can be used to sort the column in descending order. The CLICKHEADER property is
used to simulate that the column header was clicked, to force a sort. 

The column index (0, 1, 2, etc.) or column name can be specified to sort the column.

Syntax:

  PROPERTY <EnhancedDBGridComponentID> SortAsc '0'
  PROPERTY <EnhancedDBGridComponentID> SortDesc '0'

-- Example (Based on RBG9_EnhancDBGrd form included with RRBYW18)

-- To Dynamically Sort (ASC) the first column (Company)
  PROPERTY DBGrid_Customers SortAsc '0'

-- To Dynamically Sort (DESC) the first column (Company)
  PROPERTY DBGrid_Customers SortDesc '0'

-- To Dynamically Sort (ASC) the second column (City)
  PROPERTY DBGrid_Customers SortAsc '1'

-- To Dynamically Sort (DESC) the second column (City)
  PROPERTY DBGrid_Customers SortDesc '1'

  Alternative, you could also use the following PROPERTY syntax as well.
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  PROPERTY <EnhancedDBGridComponentID> SortAsc 'columnname'
  PROPERTY <EnhancedDBGridComponentID> SortDesc 'columnname'

-- To Dynamically Sort (ASC) the first column (Company)
  PROPERTY DBGrid_Customers SortAsc 'Company'

-- To Dynamically Sort (DESC) the first column (Company)
  PROPERTY DBGrid_Customers SortDesc 'Company'

-- To Dynamically Sort (ASC) the second column (City)
  PROPERTY DBGrid_Customers SortAsc 'City'

-- To Dynamically Sort (DESC) the second column (City)
  PROPERTY DBGrid_Customers SortDesc 'City'

Syntax:

  PROPERTY <EnhancedDBGridComponentID> ClickHeader '0'

  -- To Dynamically Sort the first column (Company)
  PROPERTY DBGrid_Customers ClickHeader '0'

  -- To Dynamically Sort the second column (City)
  PROPERTY DBGrid_Customers ClickHeader '1'

Alternative, you could also use the following PROPERTY syntax as well.

  PROPERTY <EnhancedDBGridComponentID> ClickHeader 'columnname'

  -- To Dynamically Sort the first column (Company)
  PROPERTY DBGrid_Customers ClickHeader 'Company'

  -- To Dynamically Sort the second column (City)
  PROPERTY DBGrid_Customers ClickHeader 'City'

67 Capture Cell Value Within Enhanced DB Grid

A new GETPROPERTY command parameter is available to capture the value of currently focused
cell in an Enhanced DB Grid. The value for the cell is stored within the specified variable.

GETPROPERTY <EnhancedDBGridComponentID> CurrentCellValue 'varname'

68 Button Alignment for Radio Group Controls

A new "Button Alignment" property for DB Radio Group and Variable Radio Group controls is
available to move to radio button on either side of the item text.
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69 Bidirectional Mode Support

New Bidirectional Mode is supported to adjust the text appearance and behavior when an
application runs in a locale that reads from right to left, instead of left to right. Bidirectional
Mode has been added to the following controls:

DB Check Box
DB Radio Button
DB Radio Group 
Variable Check Box
Variable Radio Button
Variable Radio Group

70 Find in Database Explorer Utility

The "Find in Database Explorer" search utility locates specific text in the Database Explorer for
the connected database. Use the [Ctrl] + [N] key combination to open the search dialog. 
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Search results are based upon the displayed section of the Database Explorer. For example, if
the Forms section is displayed, the utility will search all form objects for the specified text.
When the search is performed all of the columns will be scanned for the specified text. 

The search results can be limited based upon case sensitivity, direction, and limited columns to
look in.

The Database Explorer offers the following sections and appropriate columns, when configured
as "View as Details":

Tables (Name, Comment, Columns, Rows) 
Views (Name, Comment, Columns) 
Stored Procedures (Name, Comment, Size, Date/Time, Version) 
Forms (Name, Main Table, Comment, Size, Date/Time*, Version*) 
Reports (Name, Main Table, Comment, Size, Date/Time*, Version*) 
Labels (Name, Main Table, Comment, Size, Date/Time*, Version*) 
External Forms (Name, Comment, Size, Date/Time, Version) 
Applications (Name, Date/Time, Version) 
Command Files (Name, Extension, Date/Time, Size)

* = R:BASE eXtreme 9.5 (64) only.

An example of use would be a user requiring to locate the text "MAP" in all reports. After
selecting the Reports section of the Database Explorer, the search dialog can be launched
using the [Ctrl] + [N] key combination. The word "MAP" is entered and "Names and Comments"
is left as is for the "Look In" field. When the "Search" button is pressed all forms containing
"map" in the name and comment will be highlighted, one at a time, for easy selection. To move
to the next item located in the search, press the [Enter] key. 

This feature is extremely helpful for those that have databases with a significant number of
tables, views, stored procedures, forms, reports, labels, external forms, applications, and
command files.

Notes:

The search will not find text in the active or selected row.

Press the [Enter] key to move to the next item located in the search.
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71 Additional Form RBTI System Variables

Two additional RBTI System Variable have been implemented for when a form is open in the
Form Designer. 

If a form is open in the Form Designer the variable RBTI_FORM_DSGN will be defined with the
value "YES". 

If a form is open in the External Form Designer the variable RBTI_FORM_EXT_DSGN will be
defined with the value "YES". 

R>SHOW VAR
Variable                         = Value                            
      Type
--------------------------------   ------------------------------   
      -------
#DATE                            = 01/08/2014                       
       DATE    
#TIME                            = 5:22:37 PM                       
       TIME    
#PI                              = 3.14159265358979                 
       DOUBLE  
SQLCODE                          = 0                                
       INTEGER 
SQLSTATE                         = 00000                            
       TEXT    
#NOW                             = 01/08/2014  5:22:37 PM           
       DATETIME
RBTI_FORM_FORMNAME               = CustomerManagement               
       TEXT    
RBTI_FORM_DSGN                   = YES                              
       TEXT
RBTI_FORM_EXT_DSGN               = YES                              
       TEXT

An example of how the added system variable intelligence can be used is how it allows for a
developer to customize "On Close" EEPs within forms, to maintain global variables within active
development. 

When embedding code in form, it is proper programming to CLEAR all variables related to the
form in the "On Close" EEP. However, if you sill need those variables while in Form Designer,
they must be defined again. 

The new system variables permit a developer to determine which variables to CLEAR, and
which to not. 

72 Reset Form, Report, Label Version Number

When copying a form, report, or label, a check box is now available to reset the version
number. 
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The version number can also be reset by right clicking on the object and selecting "Reset
Version Number ..." from the speed menu. 

This enhancement is specific to R:BASE eXtreme 9.5 (64).

73 Default Settings for the BLOB Editor

R:BASE supports many additional default settings for the BLOB Editor. 

The settings specify the default values for the Image, Note/VarChar, Rich Text, Unicode/BSTR,
and Hex tabs of the R:BASE BLOB Editor.

73.1 Image

Default Page
specifies the default page displayed when the BLOB Editor is launched for an empty data set.
If data exists, the BLOB Editor will default to the appropriate page based on the type of data
stored. 

Default Image Format
specifies the default format when saving images

Pen Settings
Color - specifies the line color
Width - specifies the line width
Style - specifies the line style

Brush Settings
Color - specifies the fill color for the arrow start and end shapes, if defined
Style - specifies the fill style for the arrow start and end shapes, if defined

Default Font
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specifies the default text font type, size, and style

Arrow
Start Shape - specifies the arrow start shape for the line
End Shape - specifies the arrow end shape for the line

73.2 Note/VarChar

Default Page
specifies the default page displayed when the BLOB Editor is launched for an empty data set.
If data exists for the column, the BLOB Editor will default to the appropriate page based on
the type of data stored. 

Editor Font
specifies the editor text font type, size, and style
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Misc
specifies if the right margin is displayed

73.3 Rich Text

Default Page
specifies the default page displayed when the BLOB Editor is launched for an empty data set.
If data exists for the column, the BLOB Editor will default to the appropriate page based on
the type of data stored. 

Default Font
specifies the default text font type, size, and style

Misc
specifies if nonprinting characters are displayed
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73.4 Unicode/BSTR

Default Page
specifies the default page displayed when the BLOB Editor is launched for an empty data set.
If data exists for the column, the BLOB Editor will default to the appropriate page based on
the type of data stored. 

Editor Font
specifies the editor font type, size, and style
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73.5 Hex

Default Page
specifies the default page displayed when the BLOB Editor is launched for an empty data set.
If data exists for the column, the BLOB Editor will default to the appropriate page based on
the type of data stored. 

Misc
View Gutter 3D - specifies if the gutter lines are displayed
View Grid Lines - specifies if the grid lines are displayed
View Ruler - specifies if the ruler is displayed
View Focus Frame - specifies if a selection displays a solid frame or the dotted focus frame
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74 New Temporary Option for JOIN, INTERSECT, SUBTRACT,
and UNION

A TEMPORARY option has been enhanced for the JOIN, INTERSECT, SUBTRACT, and UNION
commands, to support the creation of a temporary table.

JOIN
Use the JOIN command to form a new table by combining rows from two existing tables based
on a comparison of the columns you specify.
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FORMING tblname3 
Specifies the name of the new table.

TEMPORARY 
Creates a temporary table that disappears when the database is disconnected.

tblname1 
Specifies the name of the first table to join.

USING colname1 
Specifies the columns to be compared; colname1 is a column in tblname1.

USING colname2 
Specifies the columns to be compared; colname2 is a column in tblname2.

WHERE compare_op 
States the condition used to compare columns. If omitted, the condition is = or EQ (equal). Use only the
following comparison operators in a JOIN WHERE clause:

Comparison Operator Rows are included if...

= EQ colname1 is equal to colname2 (the default)

<> NE colname1 is not equal to colname2

> GT colname1 is greater than colname2

>= GE colname1 is greater than or equal to colname2

< LT colname1 is less than colname2

<= LE colname1 is less than or equal to colname2

WITH tblname2 
Specifies the name of the second table to join.

Example:

JOIN ProdLocation USING Model WITH Product USING Model FORMING
TEMPORARY ProdDetail

INTERSECT
Use the INTERSECT command to form a new table by combining two tables that have one or
more common columns.

FORMING tblname3 
Specifies the name of the new table.

TEMPORARY 
Creates a temporary table that disappears when the database is disconnected.

tblname1 
Specifies the name of the first table to intersect.

USING collist 
Specifies which columns to include in the new table. The clause must include at least one common
column. You can use the clause to order the columns in the new table and to determine which columns
from the original tables will be in the new table. If you do not include the clause, R:BASE uses all
columns from both tables. Columns from tblname1 provide the order for rows and columns in the new
table. R:BASE adds columns from tblname2 that are not in tblname1 to the right of the columns from
tblname1. The USING clause also determines which common columns are used for comparison. For
example, if frstname and lastname are in both tables but only lastname is included in the USING clause,
INTERSECT will compare the tables based only on lastname.

WITH tblname2 
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Specifies the name of the second table to intersect.

Example:
INTERSECT Employee WITH SalesBonus FORMING TEMPORARY RepSales +
USING EmpLname, EmpID, HireDate, NetAmount, TransDate, Bonus,
BonusPct

SUBTRACT
Use the SUBTRACT command to form a new table by subtracting rows in one table from a
second table based on common columns.

FORMING tblname3 
Specifies the name of the table that is produced when you subtract one table from another.

FROM tblname2 
Specifies the name of the table from which you want to subtract another table.

TEMPORARY 

Creates a temporary table that disappears when the database is disconnected.

tblname1 
Specifies the name of the table you want to subtract from a second table.

USING collist 
Specifies the columns and order of columns that you want to include in the new table. At least one
column in the USING clause must exist in both tables. If you do not include the clause, R:BASE makes a
new table that includes all columns from both tables.

Example:
SUBTRACT SalesBonus FROM Employee FORMING TEMPORARY NoBonus

UNION
Use the UNION command to combine the columns and rows of two tables into a new table.

FORMING tblname3 
Specifies the name of the new table that is produced.

TEMPORARY 
Creates a temporary table that disappears when the database is disconnected.

tblname1 
Specifies the name of one of two tables you will combine.

USING collist 
Specifies the columns and order of columns that you want to include in the new table. At least one
column in the USING clause must exist in both tables. If you do not include the clause, R:BASE makes a
new table that includes all columns from both tables.

WITH tblname2 
Specifies the name of the second of two tables you will combine.

Example:
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UNION Employee WITH SalesBonus FORMING TEMPORARY SalesRepHistory

75 Enhanced DIALOG Command to Resize a Custom Image

The DIALOG command has been enhanced with the RESIZE_ICON parameter, to resize a
specified image to 32x32 pixels. 

Any of the below image file formats can be used. There is no size limitation, though 32x32 is
recommended. 

wmf Windows Metafiles
emf Enhanced Metafiles
ico Icon Files

bmp Windows Bitmap Files
png Portable Network Graphics

jpeg, jpg JPEG Image File
tif, tiff TIFF Image File

gif Compuserve GIF Image
jp2, j2k, jpc JPEG 2000 Image

tga, afi Truevision Targa File
vst Truevision Vista File

pcx, pcc ZSoft PC Paintbrush
dcx DCX Image File

Example: 

DIALOG 'Do you wish to continue?' vResponse vEndKey YES + 
CAPTION 'Confirm' OPTION ICON_FILE Logo128x128.jpg|RESIZE_ICON ON + 
|MESSAGE_FONT_COLOR NAVY|MESSAGE_FONT_NAME Tahoma +
|MESSAGE_FONT_SIZE 10|MESSAGE_BOLD ON 

76 Password Protection for Reports/Labels

The ability to enforce password protection in reports and labels for both design and print
capabilities has been increased. The security options are separate from the User Privileges
features that may be defined for a database.

Design
The ability to set a design password is available to protect access to a report/label in the
designer. Once the design password is set, R:BASE will prompt for a password the next time
the report/label is opened in the designer. From the main menu bar, select Report (or Label) |
Passwords | Set Design Password
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Print
The ability to set a print password is available to protect the display of a report/label. Before
the report/label is printed, R:BASE will prompt for a password. From the main menu bar, select
Report (or Label) | Passwords | Set Print Password

77 R:BASE On-Screen Keyboard Settings

Additional settings are available to provide a numeric-only keyboard, disable any number of
keys, change the caption, and specify a custom hot key to display/hide the keyboard.

Main Menu | Settings | ROSK Settings...
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The PROPERTY command support the ability to change the keyboard type.

To display a numeric-only R:BASE On-Screen Keyboard with the PROPERTY command:

PROPERTY ROSK SHOW TRUE
PROPERTY ROSK TYPE NUMPAD

To display the alpha-numeric R:BASE On-Screen Keyboard with the PROPERTY command:

PROPERTY ROSK SHOW TRUE
PROPERTY ROSK TYPE ALPHA
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78 Custom Expression Memo Field Font

A new Expression Builder option is available within the Form/Report/Label Designer to edit the
"Expression:" memo field font. 

The enhancement is helpful to clearly view all characters like commas, parenthesis, etc.

79 Enhanced Print Form Options

Additional output options are available when printing a form as it is displayed on the screen.
R:BASE eXtreme has offered the following for some time:

PROPERTY RBASE_FORM PRINT 'PRINTER'

The following new syntax option will print the currently displayed form to the current printer
using the same screen proportions, but in a size that just fits the printed page.

PROPERTY RBASE_FORM PRINT 'FITTOPAGE'

With the following, the form is printed to the current printer so that the printed image is
approximately the same visible size as on the screen (WYSIWYG).
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PROPERTY RBASE_FORM PRINT 'PROPORTIONAL'

The following will print the currently displayed form to the current printer, with no special
scaling; therefore, the printed form and how the form appears onscreen may appear squished
or stretched.

PROPERTY RBASE_FORM PRINT 'FIXEDDPI'

80 Show Row Numbers in List Views

Variable Lookup List View and DB Lookup List View controls have been enhanced with the new
"Show Row Numbers" attribute.

The setting will add a separate row number column at the far left within the list.
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The following PROPERTY command also controls the "Show Row Numbers" attribute:

PROPERTY CompID ShowRowNumbers 'TRUE'

81 Enhanced Print Preview Page Scrolling

The Report/Label Print Preview screen has been enhanced to allow users to move from page to
page using the [Shift]+Scroll action. 
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In the Reports/Labels Settings, users can switch between the options to scroll from the bottom
to the top of the next page, or focusing on the same page location when scrolling.
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82 Capture Enhanced DB Grid Sorting

New PROPERTY command support for Enhanced DB Grids has been implemented to capture the
column name when the header has been clicked upon and to capture the sort order of the
displayed records.

The CLICKHEADER parameter used with the PROPERTY command emulates a user clicking on
the column.

PROPERTY <EnhancedDBGridComponentID> CLICKHEADER 'FIELDNAME'

The CLICKHEADER parameter used with the GETPROPERTY command captures the last column
header clicked.

GETPROPERTY <EnhancedDBGridComponentID> CLICKHEADER 'varname'

The SORTORDER parameter used with the GETPROPERTY command captures the sort order of
sorted column. The possible return values are ASC and DESC. If there’s no sorted column,
property returns DESC.

GETPROPERTY GRID1 SORTORDER 'varname'

83 Shortcut Key support for Custom Form Actions

Custom Form Actions have been enhanced with keyboard shortcut support, to launch the action
when a key or a key combination is pressed. 

To assign a shortcut, right click on the specific Command Name and select "Shortcut Key" from
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the menu. 

Within the dialog, press the desired key or key combination that will be used to run the Custom
Form Action.

84 Capture Keyboard Events With New Form EEPs

To capture keyboard events, the following EEPs have been introduced within forms and
external forms: 

On Key Down EEP
On Key Press EEP
On Key Up EEP

On Key Down EEP
The On Key Down EEP will execute when the user presses a key. Within the On Key Down EEP,
the GETPROPERTY LastKeyDown parameter is accepted to recognize what key is pressed. 

Syntax:

GETPROPERTY RBASE_FORM LastKeyDown 'vKeyCode'

Where: 
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The returned integer value for vKeyCode is the virtual-key code of the of physical key
on the keyboard. 

Notes:

The virtual-key code is not to be confused with the actual keyboard characters. 
The key code value returned by the LastKeyDown syntax is only recognized within the
On Key Down EEP.
It is highly recommended to create a catch mechanism within the On Key Down EEP in
order to prevent a condition where the EEP will continually fire if a key is held down
for a long time period. See the example below where the IsKeyDown variable is used.

On Key Press EEP
The On Key Press EEP will execute when the user presses an alphanumeric or character-
generating key. Within the On Key Press EEP, the GETPROPERTY LastKeyPressed parameter is
accepted to recognize what key is pressed. 

Syntax:

GETPROPERTY RBASE_FORM LastKeyPressed 'vKey'

Where: 

The returned text value for vKey is the last alphanumeric/printable key that was
pressed. 

Notes:

The key value returned by the LastKeyPressed syntax is only recognized within the
On Key Press EEP.
The syntax cannot capture key combinations or special keys like function (Fn), arrow,
Home, Page Up, etc. However, some special key combinations can be captured such
as Ctrl+A, Ctrl+Z, and Ctrl+Enter which result to ASCII character #1 up to character
#26. Ctrl+Enter is equal to Ctrl+J. 
It is highly recommended to create a catch mechanism within the On Key Press EEP in
order to prevent a condition where the EEP will continually fire if a key is held down
for a long time period. See the example below where the IsKeyDown variable is used.

On Key Up EEP
The On Key Up EEP will execute when the user releases a key. Within the On Key Up EEP, the
GETPROPERTY LastKeyUp parameter is accepted to recognize what key is released. 

Syntax:

GETPROPERTY RBASE_FORM LastKeyUp 'vKeyCode'

Where: 

The returned integer value for vKeyCode is the virtual-key code of the of physical key
on the keyboard. 

Notes:

The virtual-key code is not to be confused with the actual keyboard characters. 
The key code value returned by the LastKeyUp syntax is only recognized within the
On Key Up EEP.

Capturing Shift, Ctrl, and Alt
The GETPROPERTY command also supports the recognition if the Shift, Ctrl, and Alt keys when
pressed.



What's eXclusive to R:BASE eXtreme 9.5 for Windows104

Copyright © 1982-2016 R:BASE Technologies, Inc.

GETPROPERTY RBASE_FORM ShiftIsPressed 'vShiftIsPressed'
GETPROPERTY RBASE_FORM CtrlIsPressed 'vCtrlIsPressed'
GETPROPERTY RBASE_FORM AltIsPressed 'vAltIsPressed'

The returned integer value for vShiftIsPressed, vCtrlIsPressed, and vAltIsPressedand is 1, if the
appropriate key is pressed. The returned value of 1 by the syntax is recognized within the "On
Key Down", "On Key Press", and "On Key Up" EEPs.

85 Enhanced Compare by Content Utility

The Compare by Content Toolbar within the R:BASE Editor is used to compare two files and to
review the command line changes within the files. The following enhancements were added for
the utility:

Added "Reload" button, to easily refresh the files displayed after changes to the
command files were made
Within the "Options" menu, a setting is available to split the file comparison vertically or
horizontally
With each new instance of R:BASE, the "Open file" dialog will remember the extension
selected in the past
When performing a comparison on two identical files, a pop-up message will appear
stating: "The selected files are identical"
When performing a comparison after loading the same file, a pop-up message will appear
stating: "The same file is opened in both panels"



Enhanced Compare by Content Utility 105

Copyright © 1982-2016 R:BASE Technologies, Inc.

86 SATTACH With Limited Columns

The SATTACH command has been enhanced with a new ONLY keyword to limit the columns
attached from an SQL data source. When adding the ONLY after the word USING, only the
columns listed will be "sattached". The syntax is supported with temporary SATTACH tables and
with column alias names.

Syntax:
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Example:

SATTACH SongList USING ONLY Song_ID, SongTitle

87 Default Printer Selection in Print Preview

The PRINT and LBLPRINT commands have been enhanced so a printer name can be specified
even if the target is SCREEN. If a printer name is provided, that printer becomes the default
selection in the printers drop-down of the print dialog.

--Print dialog, initial printer is OS default printer
PRINT ColumnarReport OPTION SCREEN

--Print dialog, initial printer is Samsung SCX-3400 Series
PRINT ColumnarReport OPTION SCREEN|PRINTER_NAME 'Samsung SCX-3400
Series'

--Print dialog, initial printer is HP LaserJet 1018
LBLPRINT CustShpLabl OPTION SCREEN|PRINTER_NAME 'HP LaserJet 1018'

88 New Count Down Timer Control

A new Count Down Timer control has been implemented for forms. The functionality places a
non-visual object that performs a count down process. 

The object is only visible at design-time and works by attaching to an existing control. Examples
of controls to assign the timer to include Static Text, Panel, Enhanced Panel, LED Text Label,
Digital Clock, Meter, or any control that has "Text" or "Caption" properties.

Settings are available to specify the timer start time, display format, and the control that will
display the time counter.
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EEPs are available to run for each second the timer decrements and for when the count down
ends.

PROPERTY command parameters are available to start and stop the timer.

  PROPERTY CountDownTimer1 STARTTIMER 'TRUE'

  PROPERTY CountDownTimer1 STOPTIMER 'TRUE'
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89 Additional Form RBTI System Variables

Three new form-based RBTI System Variables have been created for internal and external
forms:

RBTI_FORM_CLICKED - if a control is CLICKED this variable is set to the clicked control's
Component ID property (if property exists). The value can then be used by the PROPERTY/
GETPROPERTY commands to manipulate the control.

RBTI_FORM_DBLCLKED - if a control is DOUBLE CLICKED this variable is set to the double
clicked control's Component ID property (if property exists). The value can then be used by the
PROPERTY/GETPROPERTY commands to manipulate the control.

RBTI_FORM_CTRLTEXT - if a control is CLICKED this variable is set to the clicked control's
"Caption" or "Text"' property. Display-only controls like a Label and Panel use the "Caption"
property to hold text. For entry controls like DB/Variable Edit or Combo Boxes, the property to
hold text is "Text". When setting the value of RBTI_FORM_CTRLTEXT, the control is first checked
if it has the "Caption" property. If "Caption" was not found "Text" is used. If both "Caption"
and "Text" were not found, the variable is set to null. 

90 New Advanced Variable Rich Edit Control

The Advanced Variable Rich Edit control has been added to forms. The Advanced Variable Rich
Edit offers many additional attributes over the existing Variable Rich Edit control.

Disabled Double Click
Restricts display of the R:BASE BLOB Editor when the user double clicks on the field

Want Shift+Returns
When checked, the [SHIFT]+[ENTER] keys will start a new paragraph or start a new line inside
the paragraph

Hide Read Only Caret
When checked the editor hides the caret in "read only" mode

No Image Resize
When checked, resizing of images with the mouse is prevented

Allow Selection
If enabled (default), user can select contents using the mouse or keyboard

Single Click
If enabled, a double click is generated with a single mouse click

Client Text Width
If enabled, text always wraps to fit client width

Show Checkpoints
If enabled, all checkpoints are shown

Show Page Breaks
If enabled (default), page breaks are shown as horizontal lines 

Show Special Characters
If enabled, non-printing characters are displayed with special marks: spaces, non breaking
spaces, paragraph breaks, line breaks, tabs, soft hyphens in Unicode text. 
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Double Click Selects Word
If enabled (default), double click on a word selects it (and double click on non-text item selects
the item)

Right Clicking Deselects
If enabled (default), right click outside the selected area deselects 

Disable Drag
If enabled, dragging from the control is not allowed 

Show Item Hints
If enabled, hints for the items can be displayed. Show Hint must also be enabled.

Fast Formatting
Increases performance, but at the cost of some resources

Tip! - A Variable Rich Edit control can be automatically converted to an Advanced Variable Rich
Edit control. Within the Form Designer, right click on the Variable Rich Edit and select the
"Convert to Advanced Variable Rich Edit" option.

91 New Filter Features for Enhanced DB Grids

The Enhanced DB Grid has been updated with an additional "On DB Grid Filter Change" EEP, to
run when the filter is changed. 
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Also, a new PROPERTY command parameter is now supported to change the filter type for an
Enhanced DB Grid.

PROPERTY <component_id> FILTERTYPE 'Value'

Examples:

PROPERTY EDBGrid_Customers FILTERTYPE 'EQUAL'
PROPERTY EDBGrid_Customers FILTERTYPE 'LIKE'
PROPERTY EDBGrid_Customers FILTERTYPE 'CONTAINS'



Preselected Values Within CHOOSE 111

Copyright © 1982-2016 R:BASE Technologies, Inc.

92 Preselected Values Within CHOOSE

The CHOOSE command includes two new OPTION parameters to preselect a choices in the
displayed list. 

INITPOS specifies the preselected initial position(s) for the items in the list. The first
value in the list is assigned zero, and increments for the number of values in the list.

INITVAL specifies the preselected initial value(s) for the items in the list.

INITPOS will be processed first, then INITVAL. If multiple selection is allowed both will be
applied. Otherwise, it is possible that the initial selection specified in INITPOS will be
overwritten by value in INITVAL. 

Example:

CHOOSE vChoose FROM #TABLES CHKBOX 3 +
TITLE 'Table List' LINES 20 FORMATTED +
OPTION TITLE_FONT_SIZE 22 +
|TITLE_FONT_NAME TAHOMA +
|INITVAL CONTACT,CUSTOMER,EMPLOYEE

93 Custom Menu Bar Colors

The form Menu Bar Designer has been enhanced with an "Appearance" tab to customize the
menu bar item fonts and colors. 
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The following PROPERTY command parameters are available for customizing the form menu bar:

USE_CUSTOM_MENUBAR - ON/OFF
MENUBAR_USE_FORM_COLOR - ON/OFF
MENUBAR_HIGHLIGHT_COLOR- Color Value
MENUBAR_HIGHLIGHT_TEXT_COLOR- Color Value
MENUBAR_FONT_NAME- Font Value
MENUBAR_FONT_SIZE- Integer Value
MENUBAR_FONT_COLOR- Color Value
MENUBAR_BACK_COLOR- Color Value
MENUBAR_FONT_BOLD - ON/OFF
MENUBAR_FONT_ITALIC - ON/OFF
MENUBAR_FONT_UNDERLINE - ON/OFF
MENUBAR_FONT_STRIKEOUT - ON/OFF

Example 01:

PROPERTY RBASE_FORM USE_CUSTOM_MENUBAR ON/OFF
PROPERTY RBASE_FORM MENUBAR_USE_FORM_COLOR 'ON'
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Example 02:

PROPERTY RBASE_FORM USE_CUSTOM_MENUBAR 'ON'
PROPERTY RBASE_FORM MENUBAR_HIGHLIGHT_COLOR 'RED'
PROPERTY RBASE_FORM MENUBAR_HIGHLIGHT_TEXT_COLOR 'GRAY'
PROPERTY RBASE_FORM MENUBAR_FONT_NAME Tahoma
PROPERTY RBASE_FORM MENUBAR_FONT_SIZE 8
PROPERTY RBASE_FORM MENUBAR_FONT_COLOR 'BLACK'
PROPERTY RBASE_FORM MENUBAR_BACK_COLOR 'WHITE'
PROPERTY RBASE_FORM MENUBAR_FONT_BOLD 'ON'
PROPERTY RBASE_FORM MENUBAR_FONT_ITALIC 'OFF'
PROPERTY RBASE_FORM MENUBAR_FONT_UNDERLINE 'OFF'
PROPERTY RBASE_FORM MENUBAR_FONT_STRIKEOUT 'OFF'

94 New CHECKPROP Setting

PROPERTY and GETPROPERTY command errors can now displayed if a "property" value is invalid.
The enhancement applies to both forms and reports. The errors are only displayed if a new
operating condition CHECKPROP is set ON. The default value is set to OFF. 

SET CHECKPROP ON/OFF

95 Check Box Support in List View Controls

Check boxes are now supported in DB Lookup List View, Variable Lookup List View, and List
View controls. The new "Show Check Boxes" attribute is available within the properties. When
displayed, the check box will always appear within the first column.

Within EEPs, users can get/set the check status of an item using

PROPERTY CompID 'ITEMS[1]->CHECKED' 'TRUE'
GETPROPERTY CompID 'ITEMS[1]->CHECKED' 'VarName'

The following specifies if a check box column is displayed at the far left of the list

PROPERTY CompID 'CHECKBOXES' 'TRUE'

The following returns a string of comma-separated "key field" values for checked items

GETPROPERTY CompID 'CHECKEDROWS' 'VarName'

The following returns the number of checked items

GETPROPERTY CompID 'CHECKEDROWCOUNT' 'VarName'
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Example:

SET VAR vItem TEXT = NULL
GETPROPERTY ListView_Customers 'ItemIndex' 'vItem' 
SET VAR vItemProp TEXT = ('ITEMS[' + .vItem + ']->CHECKED') 
GETPROPERTY ListView_Customers .vItemProp 'vItemsChecked' 
GETPROPERTY ListView_Customers 'ITEMS->COUNT' 'vItemsCount' 
RECALC VARIABLES 
RETURN
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96 New NOCALC Setting

A new setting, NOCALC, has been implemented to suppresses or processes computed column
expressions with the UNLOAD and LOAD commands. 
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If NOCALC is set to ON, then the UNLOAD command, as it creates LOAD statements, will
generate new "load only" commands as it starts each table. These "load only" commands
would be CALC and NOCALC, which operate in a fashion similar to CHECK/NOCHECK and FILL/
NOFILL and NUM/NONUM commands. The UNLOAD command will output the current values for
the computed columns as it unloads the data. 

NOCALC allow users to preserve original computed values when using UNLOAD/LOAD to move
data, or when rebuilding a database with UNLOAD ALL.

SET NOCALC ON/OFF

In processing a LOAD command for a table, if it encounters a NOCALC command, then
regardless of the current setting for NOCALC, the LOAD command will expect values for every
column, whether computed or not. The values from the input would then be stored in those
columns that are computed, rather than doing the actual computation. 

Other methods for adding rows to a table, such as APPEND , the Data Browser, or a form,
would all still calculate each computed column. Only the LOAD command with its special CALC/
NOCALC commands could input a value into a computed column without doing the computation.

R:BASE stores the NOCALC setting with the database.

97 Set Background Color for Multiple Forms

A new option has been implemented to change the background color for multiple forms at once,
similar to changing themes for multiple forms. The option is available within the Forms section of
the Group Bar and also within the right click pop-up menu. 
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98 R:BASE Optimizations

1. Optimized form load process. In previous releases the entire form is always instantiated to
detect/execute On Before Start EEP and On Before Design code. In the updated release the
form is no longer instantiated resulting to faster load times -- both design-time and run-
time.

2. Removed unused columns when fetching forms and reports metadata. Unnecessary memory
allocations were also removed.

3. Improved detection of compressed database objects (forms, reports, labels). Duplicate
loading of resources were cleaned up.

4. Improved detection of active form. Previous code relied on exception handling. Updated
method properly sets the internal form reference to NULL when form is destroyed.

5. Objects that are created on startup but are used at a later time, or no used at all, were
created on-demand resulting to faster application startup.

6. Removed unnecessary validations in handling variables and database object. This also
resulted to significant reduction in number of function calls between frontend and the
database engine to accomplish the same task.

7. Removed duplicate processing of grid footers when form datasets are navigated.

8. The process that is only applicable when form has scroll bars is executed every time the
mouse wheel is scrolled even if form has no scroll-bars. This was corrected. This resulted to
faster scrolling of form contents.

9. Single character search in strings was replaced with faster code. This resulted to faster text
parsing.

10.Reworked embedded plugin detection in compiled applications. Also removed duplicate
loading of embedded resources. Startup times should see significant improvement in loading
time.

11.Removed unnecessary variable recalculation on report data traversal.

12.Report to PDF: Reworked the text encoding function to minimize memory allocation/
deallocation.

13.Report to PDF: Replaced font/typeface checking whether it is a symbol or not. Replaced with
a lookup method instead of checking with the OS every time.

99 Reset Property for List View Controls

A new RESET property has been implemented for List View controls. The following command
clears the current sort settings and refreshes the list view.

PROPERTY ListViewCompID RESET 'TRUE'

100 Exclusive Mode in Tree Views

A new EXCLUSIVEMODE property is supported for the Tree View controls to only open one node
at time. The setting is available when the "Auto Expand" property is also set to false.
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PROPERTY TreeViewCompID EXCLUSIVEMODE 'TRUE'

101 Data Browser Export Options

The Data Browser settings have been enhanced with the additional Export Options:

Open After Export - launches the file created based on the current file associated
program, when the export is complete

Blank If Zero - exports all zero values as blank fields
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102 Check Box Support in List Box Controls

Check boxes are now supported in all List Box controls. PROPERTY/GETPROPERTY parameters
are available to manipulate and capture check box data. The new "Show Check Boxes"
attribute is available within the properties. When displayed, the check box will always appear
within the first column.
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Within EEPs, users can get/set the check status of an item. When using the GETPROPERTY
command for multi-select list boxes, this is the topmost item.

PROPERTY CompID 'ITEMS[1]->CHECKED' 'TRUE'
GETPROPERTY CompID 'ITEMS[1]->CHECKED' 'VarName'

The following specifies if a check box column is displayed at the far left of the list

PROPERTY CompID 'CHECKBOX' 'TRUE'

The following returns a string of comma-separated "key field" values for checked items

GETPROPERTY CompID 'CHECKEDITEMS' 'VarName'

The following returns the number of checked items
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GETPROPERTY CompID 'CHECKEDITEMCOUNT' 'VarName'

Example:

SET VAR vItem TEXT = NULL
GETPROPERTY ListBox_Customers 'ItemIndex' 'vItem' 
SET VAR vItemProp TEXT = ('ITEMS[' + .vItem + ']->CHECKED') 
GETPROPERTY ListBox_Customers .vItemProp 'vItemsChecked' 
GETPROPERTY ListBox_Customers 'ITEMS->COUNT' 'vItemsCount' 
RECALC VARIABLES 
RETURN

103 Relational Operators in Enhanced DB Grid Background
Color Mapping

The Background Color Mapping feature within Enhanced DB Grids now supports all data types
(rather than just TEXT), as well as relational operators, making custom color highlighting in
grids a much more powerful feature.

Within the "Text Value/Expression" field of the Colors dialog, several formats are available to
specify relational operators with variables:

=(...) 
<(...) 
>(...) 
<>(...)
>=(...)
<=(...)

The value(s) inside the parenthesis can be a variable in ".vCompName" format or a combination
of variable and literals, for example: ".vCompName Corporation". 

Notes:

It is important to avoid placing a leading or trailing space within the Text Value/
Expression field.
It is possible that rules will overlap. It is important to note that rules are evaluated from
top to bottom within the list of color mappings. The first rule to be satisfied is
implemented.

Examples:

Example 1: Highlight all negative values: <(0)
Example 2: Highlight dates that are later than today: >(.#DATE)
Example 3: Highlight all dollar amount greater than $100: >($100.00)
Example 4: Highlight all values that match a defined variable: =(.VarName)
Example 5: Highlight all values that match a defined variable and text: =(.vCompName
Corporation)
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104 Expand Nodes in LoadDirectoryName Plugin

Two additional options are supported for the LoadDirectoryName Plugin, for expanding the
initial node and for expanding nodes with a single click.

EXPAND_INITIAL_FOLDER - Determines if; the initial folder node is expanded (ON), the
initial folder and the sub-folders are expanded (CASCADE), the initial folder is not
expanded (OFF, default).

AUTO_EXPAND - Determines if single click will expand/close a node when clicked.
Otherwise double click is used. This option is for clicking on nodes, not the tree structure.

Example:

PLUGIN LoadDirectoryName vDirName+
|PATH_NAME C:\RBTI\ +
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|SHOW_BUTTONS ON+
|CREATE_FOLDER_ICON OFF+
|DELETE_FOLDER_ICON OFF+
|WIDTH 500+
|HEIGHT 400+
|READ_ONLY ON+
|INCLUDE_NON_FOLDERS OFF+
|SHOW_HIDDEN OFF+
|OK_BUTTON_CAPTION 'Load Folder'+
|EXPAND_INITIAL_FOLDER CASCADE+
|AUTO_EXPAND ON

105 New Date/Time Picker EEPs

Two new EEPs have been added to the DB and Variable Date/Time Picker controls, which
execute when the drop-down calendar is displayed or hidden, allowing for improved date/time
verification.

On Drop Down EEP - triggered when the drop-down calendar is displayed 

On Close Up EEP - triggered when the drop-down calendar is hidden 
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106 Find and Expand Tree View Nodes

New Tree View control properties are available to expand nodes and to find a node based upon
the node path. The properties are specifically used with the PROPERTY command.

EXPAND - controls whether a node is expanded or collapsed; valid options are ON/
CASCADE/OFF
FINDPATHNODE - places focus and selects a node using the full path

The EXPAND property works as if the user manually expanded/collapsed the node. 

Example:

PROPERTY TreeView1 FINDPATHNODE 'Orders\Region 6\Estimates'
PROPERTY TreeView1 EXPAND 'ON'
PROPERTY TreeView1 SET_FOCUS 'TRUE' 
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107 Column-Level Filter Types for Enhanced DB Grids

Enhanced DB Grids now support column-level filter types, allowing different filter types to be
applied to different columns. Available filter include:

Same As Grid (default)
CONTAINS
LIKE
EQUAL

108 Added "Reset User Count" Option

A new "Reset User Count" option has been added to R:BASE to reset the database connection
user count, only if there are no other valid connections to the database. If valid connections
exist, the count will not reset.

The menu option is available by selecting "Tools" > "Database Connections" > "Reset User
Count" from the main menu bar. A confirmation dialog will be displayed.
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109 Enhanced ODBC Table Attaching

The process to attach ODBC tables to a database has been enhanced to allow R:BASE to query
the external source and assign keys appropriately. Previously, R:BASE would attach the source
table without attempting to assign accurate qualkeys. 

When attaching ODBC tables by selecting "Utilities" > "Attach SQL Database Tables" from the
menu bar, the dialog has been enhanced with the "Attach USING ALL" check box, rather than
automatically adding USING ALL to the underlying SATTACH command. 
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110 R:BASE Editor "Hot Key" Tab Navigation

When using the built-in R:BASE Editor, the hot keys [Ctrl+Alt+N] to move to the next tab and
[Ctrl+Alt+P] to move to the previous tab have been implemented. [Ctrl+Alt+,] for the previous
tab and [Ctrl+Alt+.] for the next tab were also implemented.

111 Enhanced Replacing Values in the Data Browser

When using the "Replace All Column Values" menu option within the Data Browser, the dialog
box has been enhanced to eliminate the limit of 51 characters. A limit is not required as the
replacement value could be an expression that comprises of many columns combined. The field
was also updated to allow the use of the Data Dictionary.
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112 Enhanced Button Options for PAUSE Command

The PAUSE command has been enhanced to support a font size with bold, italic, underline, and
strikeout types for the button text. The button width and height can also be modified. 

PAUSE 2 USING 'Message Text' CAPTION 'Caption Text' +
ICON INFO BUTTON 'Button Text' +
OPTION BUTTON_COLOR -16777216 +
|BUTTON_FONT_NAME Tahoma +
|BUTTON_FONT_COLOR -16777208 +
|BUTTON_FONT_SIZE 10 +
|BUTTON_FONT_BOLD ON +
|BUTTON_WIDTH 100 +
|BUTTON_HEIGHT 35

The PAUSE command syntax builder plugin (Utilities > Plugins") has been enhanced to allow
easier creation of custom PAUSE messages.



What's eXclusive to R:BASE eXtreme 9.5 for Windows130

Copyright © 1982-2016 R:BASE Technologies, Inc.

113 Enhanced YES/NO Button Options for DIALOG Command

The YES/NO button parameters for the DIALOG command have been enhanced to support a
font name, with bold, italic, underline, and strikeout font types for the button text. The button
widths can also be modified. 

DIALOG 'Type Message Here ...' vResponse vEndKey YES +
CAPTION 'Type Caption Here ...' ICON INFO +
OPTION BUTTON_YES_COLOR 32768 +
|BUTTON_NO_COLOR 255 +
|BUTTON_YES_FONT_BOLD ON +
|BUTTON_YES_FONT_COLOR -16777208 +
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|BUTTON_YES_FONT_NAME Tahoma +
|BUTTON_YES_FONT_SIZE 10 +
|BUTTON_YES_WIDTH 85 +
|BUTTON_NO_FONT_BOLD ON +
|BUTTON_NO_FONT_COLOR -16777208 +
|BUTTON_NO_FONT_NAME Tahoma +
|BUTTON_NO_FONT_SIZE 10 +
|BUTTON_NO_WIDTH 85

 
The DIALOG command syntax builder plugins (Utilities > Plugins") have been enhanced to allow
easier creation of custom DIALOG messages.
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114 New Support for Native Form Display

A new application property has been implemented allowing forms to be displayed as "native",
which eliminates the use of themes (R:BASE and operating system) on R:BASE form properties.
With the setting OFF (default), the feature is disabled.

PROPERTY APPLICATION NATIVE_FORMS 'ON'
PROPERTY APPLICATION NATIVE_FORMS 'OFF'

The following is an R:BASE form example with the NATIVE_FORMS property set to OFF, as the
default value.

The following is an R:BASE form example with the NATIVE_FORMS property set to ON. Note the
different button sizes in the title bar, and the thin form border.

Pros and Cons
The NATIVE_FORMS property is offered as an optimization option to eliminate the theme-based
drawing, painting, refreshing, etc., and to improve performance. There is however a
functionality trade-off. It is important to note that in native mode some items would be
disabled, such as the drop-down menu on the form title bar, or the ability to have only the
minimize and X buttons on the title bar. Users may be required to rethink a form's design and
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presentation when the NATIVE_FORMS property is set to ON.

Native Form Use
The NATIVE_FORMS property is a global value. When the PROPERTY is ON, "any" launched form
will be displayed as native. It’s up to the user to decide how to manipulate the property. To
enable native forms on a per-form basis, the property should be set ON before a form is
launched with the REFF, BROWSE, EDIT, and ENTER commands, and then OFF within the form's
"On After Start" EEP. 

If a majority of the forms are to be native, then the property can be set to ON within the
application on startup. For example, if there are hundreds of forms that should be native and
just a dozen or so to be theme-based, then NATIVE_FORMS can be set to ON within the startup
process, and then for each of the forms to be theme-based, the property can be turned OFF
before a form is launched and set ON again within the "On After Start" EEP. Thus, setting the
property to limit the effect to the forms be launched.

115 New Support for Native Control Display

A new application property has been implemented allowing form controls to be displayed as
"native", which eliminates the use of themes (R:BASE and operating system) on the R:BASE
control properties. With the setting OFF (default), the feature is disabled.

PROPERTY APPLICATION NATIVE_CONTROLS 'ON'
PROPERTY APPLICATION NATIVE_CONTROLS 'OFF'

The following is an R:BASE form example with the NATIVE_CONTROLS property set to OFF, as
the default value.

The following is an R:BASE form example with the NATIVE_CONTROLS property set to ON. Note
the different style for the buttons and panel the buttons are enclosed within.
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Pros and Cons
The NATIVE_CONTROLS property is offered as an optimization option to eliminate the theme-
based drawing, painting, refreshing, etc., and to improve performance. There is however a
functionality trade-off. It is important to note that in native mode some items will appear
different. Users may be required to review and alter the style of a form's design and
presentation when the NATIVE_CONTROLS property is set to ON.

Native Form Use
The NATIVE_CONTROLS property is a global value. The setting is dependent on the
NATIVE_FORMS property, and will only take effect when NATIVE_FORMS is set ON. When the
PROPERTY is ON, some controls within a launched form will be displayed as native. It’s up to the
user to decide how to manipulate the property. To enable native forms on a per-form basis, the
property should be set ON before a form is launched with the REFF, BROWSE, EDIT, and ENTER
commands, and then OFF within the form's "On After Start" EEP. 

116 Display Format for Form Database and Variable Controls

A Display Format property is now supported for database and variable controls. The Display
Format is only available for non-text type data values. When the control has focus, the value
will be formatted in its native format. Upon exit, the Display Format value is applied.

Examples:

PROPERTY CI_LastUpdate DISPLAYFORMAT 'dddd, mmmm dd, yyyy'

PROPERTY CI_UpdateTime DISPLAYFORMAT 'h:nn:ss AM/PM'

PROPERTY CI_TotalAmount DISPLAYFORMAT '#,0.00;-#,0.00'

PROPERTY CI_FinalCalib DISPLAYFORMAT '#.#,E+00'
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Only the Variable Label and Variable Edit controls will include an extra property field within the
Form Designer.

117 Enhanced DB Grid - On After Cell Click EEP

A new "On After Cell Click" EEP has been introduced for the Enhanced DB Grid control, to fire
after a cell has been clicked.

The existing "On DB Grid Cell Click" EEP occurs before any changes to the dataset are made.
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The new "On DB Grid After Cell Click" EEP has been added to occur after the click.

118 Blank When Zero and NULL Format Properties

The "Blank When Zero" and "NULL Format" properties have been added to the Variable Memo
and DB Memo controls within the Report/Label Designers.

"Blank When Zero" specifies an object will display nothing if the value of the variable is zero.

"NULL Format" specifies the display format for a NULL value.
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119 Automatic Backup Option for External Form Files

A new "Create Backup Copy" option was added to the Form Settings for external form files.
When enabled, R:BASE saves a backup copy of external form files (.rff). The backup copy will
reside in the same folder as the original file, only the file extension will contain .rf~.

The backup option for external form files, mimics the settings which already exist for command
files, application files, and the R:BASE configuration file. 
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120 Enhanced DATETIME support for DB/Variable Edit
controls

The DB Edit and Variable Edit controls now support the ability to display a date/time editor, if
the control is based upon a DATETIME data type. The date/time editor will open if the control is
double clicked or if [Alt+Insert] is pressed. 

If exists, the control hint will be used as the date/time editor title bar text. 
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Note that double click will only work if there is no EEP assigned to the double click event, nor a
defined pop-up menu assigned to the control.

121 New Query Driven RBTI System Variable

A new RBTI System Variable has been implemented to store a view name when the Query
Builder is utilized. 

The RBTI_QBE_NAME variable will be defined with the view name after any "Save" menu
options are used to create a new object, and will also store a view name after the query is
opened and closed within the Query Builder.

R>SHOW VAR
Variable                         = Value                            
      Type
--------------------------------   ------------------------------   
      -------
#DATE                            = 07/09/2015                       
       DATE    
#TIME                            = 10:53                            
       TIME    
#PI                              = 3.14159265358979                 
       DOUBLE  
SQLCODE                          = 0                                
       INTEGER 
SQLSTATE                         = 00000                            
       TEXT    
#NOW                             = 07/09/2015 10:53                 
       DATETIME
RBTI_QBE_NAME                    = SalesByEmployee                  
       TEXT

Knowing the view name (RBTI_QBE_NAME), users can then capture get the SYS_TABLE_ID from
the SYS_TABLES system table, and then gather the "SYS_COLUMN_LIST" and "SYS_QUERY" for
the the entire view syntax from the SYS_VIEWS system table. 

122 Added R:BASE Editor Setting for Trailing Spaces

A new "Keep Trailing Spaces" setting has been added to the R:BASE Editor, within the "String"
menu tab. When checked, the setting will retain trailing spaces added at the end of code lines.
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123 New COLCHECK View Setting

A new setting, COLCHECK, has been implemented which specifies if columns will be checked for
consistency when making views. When COLCHECK is ON (the default), view alias/column names
will be checked for consistency to other occurrences of those names in the database, when the
view is created.

SET COLCHECK ON/OFF

Similar checking is already in place when creating or modifying tables, and when attaching
tables to a database, where R:BASE requires an alias that does not cause name/data type
conflicts.

An impact may exist for a view that has already been defined, because when COLCHECK is on,
the values generated for the view will follow the data type of the alias. If an error occurs, the
view definition should be reviewed.

If an application requires COLCHECK be off to define a view that, the proper proper results
should not be expected once COLCHECK is switched back to ON when using the view. If a view
needs to be created with COLCHECK off, it also needs to be used with COLCHECK off.
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Variable Check Box     83

Variable Edit     50, 53, 138

Variable Form     42

Variable Lookup List View     77, 98, 113

Variable Memo     58, 136

Variable Radio Button     83

Variable Radio Group     82, 83

Variable Spinner     67

Version     55

version number    

form     85

label     85

report     85

view     66, 139, 140

- W -
warning     44

WHERE Builder     55

WHERE Clause     27

Whole Word     41

WINAUTH     8, 12
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